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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
Xerox® printer. 
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Electrical Safety 

This section includes: 

 General Guidelines ........................................................................................................................................................... 12 

 Power Cord ......................................................................................................................................................................... 12 

 Telephone Line Cord ....................................................................................................................................................... 13 
 

 

General Guidelines 
 

 WARNINGS:  

 Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electrical shock. 

 Do not remove the covers or guards that are fastened with screws unless you are 
installing optional equipment and are instructed to do so. Turn off the printer when 
performing these installations. Disconnect the power cord when removing covers and 
guards for installing optional equipment. Except for user-installable options, there are 
no parts that you can maintain or service behind these covers. 

 

The following are hazards to your safety: 

 The power cord is damaged or frayed. 

 Liquid is spilled into the printer. 

 The printer is exposed to water. 

 The printer emits smoke, or the surface is unusually hot. 

 The printer emits unusual noise or odors. 

 The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 

1. Turn off the printer immediately. 

2. Disconnect the power cord from the electrical outlet. 

3. Call an authorized service representative. 
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Power Cord 

 Use the power cord supplied with your printer. 

 Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the 
outlet. 

 Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly. 
Electrical products can be hazardous if misused. 

 

 Only use an extension cord or power strip designed to handle the electrical current capacity of the 
printer. 

 Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

 Do not place the printer in an area where people can step on the power cord. 

 Do not place objects on the power cord. 

 Do not plug or unplug the power cord while the power switch is in the On position. 

 If the power cord becomes frayed or worn, replace it. 

 To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to 
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Telephone Line Cord 
 

 WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 

 Do not remove the paper source tray that you selected in either the print driver or control panel while 
the printer is printing. 

 Do not open the doors when the printer is printing. 

 Do not move the printer when it is printing. 

 Keep hands, hair, neckties, and so on away from the exit and feed rollers. 

 Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 
the protective covers. 

 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox® representative or go to www.xerox.com/environment_europe. 
 

Printer Location 

 Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To 
find the weight for your printer configuration, see Physical Specifications on page 191. 

 Do not block or cover the slots or openings on the printer. These openings are provided for 
ventilation and to prevent overheating of the printer. 

 Place the printer in an area where there is adequate space for operation and servicing. 

 Place the printer in a dust-free area. 

 Do not store or operate the printer in an extremely hot, cold, or humid environment. 

 Do not place the printer near a heat source. 

 Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 

 Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 
system. 

 Do not place the printer in locations susceptible to vibrations. 

 For optimum performance, use the printer at the elevations specified in Elevation on page 193. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=environmenteu&Language=English
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Printer Supplies 

 Use the supplies designed for your printer. The use of unsuitable materials can cause poor 
performance and a possible safety hazard. 

 Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 

 Store all supplies in accordance with the instructions given on the package or container. 

 Keep all supplies away from the reach of children. 

 Never burn supplies. 

 When handling supplies, avoid skin or eye contact. Eye contact can cause irritation and 
inflammation. Do not attempt to disassemble supplies, which can increase the risk of skin or eye 
contact. 

 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

 Do not attempt any maintenance procedure that is not described in the documentation supplied 
with your printer. 

 Do not use aerosol cleaners. Clean with a dry lint-free cloth only. 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa  
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=recyclesupplies&Language=English%20%20
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Printer Symbols 

The following safety symbols appear on the printer. 
 

Symbol Description 

 

Warning or Caution: 

Ignoring this warning could cause serious injury or even death. 

Ignoring this caution could damage property. 

 

Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Do not burn the item. 

 

Do not touch components with this symbol. Personal injury could result. 

 

Hot surface. Wait the indicated time before handling. 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox® product and supplies, 
contact the following customer help lines: 

United States: 1-800 828-6571 

Canada: 1-800 828-6571 

Europe: +44 1707 353 434 

For product safety information in the United States, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=environmenteu&Language=English
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Parts of the Printer 

This section includes: 

 Front View ........................................................................................................................................................................... 20 

 Rear View ............................................................................................................................................................................ 21 

 Control Panel ..................................................................................................................................................................... 21 
 

 

Front View 

 
 

1. Bypass Tray 

2. Width Guides 

3. Output Tray 

4. Output Tray Extension 

5. Control Panel 

6. Automatic Document Feeder 

Available on WorkCentre 6015N/NI Color 
Multifunction Printer only. 

7. Side Door 

8. Document Glass 

9. Cleaning Rod 

10. Power Switch 

11. Front Cover 

12. Bypass Tray 

13. Main Tray 

14. Slide Bar/Length Guide 

15. USB Memory Port 
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Rear View 

 
 

1. Rear Cover 

2. Transfer Roller 

3. Paper Chute 

4. Registration Roller 

5. Transfer Belt 

6. Fuser Roller Release Levers 

7. Rear Cover Release Lever 

8. Ethernet Connection 

Available on WorkCentre 6015N/NI Color 
Multifunction Printer only. 

9. USB Port 

10. Line In/Out (fax/telephone) 

Available on WorkCentre 6015N/NI Color 
Multifunction Printer only. 

11. Power Connector 
 
 

Control Panel 

The control panel consists of a display, a keypad, and buttons you press to control the functions available 
on the printer. The control panel: 

 Displays the current operating status of the printer. 

 Provides access to copy, print, scan, and fax features. 

 Provides access to information pages. 

 Prompts you to load paper, replace supplies, and clear jams. 

 Displays errors and warnings. 

For details, see Control Buttons and Indicators on page 21. 
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Control Panel Buttons and Indicators 

 

1. One Touch keypad: Use to speed dial a phone 
number. Available on WorkCentre 6015N/NI Color 
Multifunction Printer only. 

2. Copy, Scan, Print, and Fax buttons: Press to use the 
Copy, Scan, Print, and Fax menus on the display 
screen. Fax button available on WorkCentre 
6015N/NI Color Multifunction Printer only. 

3. Arrow Buttons: Press to move up, down, forward, and 
back through the menus. 

4. Job Status button: Displays lists of the active or 
completed jobs on the touch screen. 

5. System button: Switches the display to the System 
menus. 

6. Alphanumeric keypad: Use to enter letters and 
numbers for names and phone numbers. 

7. Redial/Pause button: Press to recall the last fax 
number used or to insert pauses in fax numbers. 
Available on WorkCentre 6015N/NI Color 
Multifunction Printer only. 

8. Speed Dial button: Press to access directories of 
group or individual fax telephone numbers. Available 
on WorkCentre 6015N/NI Color Multifunction Printer 
only. 

9. Wake Up/Power Saver button: This button is 
illuminated in Energy Saver mode. Push the button to 
exit Energy Saver mode. 

10. Clear All button: Clears all current settings for print, 
copy, scan, or fax back to default settings. 

11. Stop button: Cancels the current job. 

12. Start button: Press to start a copy, scan, or fax job. 

13. Status indicator: The green or red light indicates 
printer status: 

Lights green when the printer is ready to receive 
data. 

Blinks green when the printer is busy receiving data. 

Lights red to indicate an error condition or warning 
that requires your attention. 

Blinks red when an error occurs that requires 
technical support. 

Off when the printer is in Energy Saver mode. 

14. Cancel/Clear button: In menus, deletes a single 
character each time the button is pressed. 

15. Address Book button: Press to access the fax and 
email address books. Available on WorkCentre 
6015N/NI Color Multifunction Printer only. 

16. OK button: Press to accept the selected setting. 

17. Back/Return button: Press to navigate up one level 
in the menu. 

18. Display Screen: Shows status messages, menus, and 
toner levels. 

19. Color Mode button: Press to switch between Color 
and Black and White modes for your copy, fax, and 
scan jobs. 

20. Black and White/Color indicators: The upper light 
indicates Black and White mode. The lower light 
indicates Color mode. 
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Control Panel Symbols 
 

Symbol Name Description 

 

Copy Allows you to change job settings for copy jobs. 

 

Scan Allows you to change job settings for scan jobs. 

 

Print Prints from USB memory. 

 

Fax 

Available on 
WorkCentre 6015N/NI 
Color Multifunction 
Printer only. 

Allows you to change job settings for fax jobs. 

 

Job Status Displays active jobs. 

 

System Displays or closes the System Menu screen. 

 

Address Book 

Available on 
WorkCentre 6015N/NI 
Color Multifunction 
Printer only. 

Allows you to access the printer address book. 

 

Forward Arrow Moves one level down in menu selections or moves the cursor to the 
right when setting a value. 

 

Back Arrow Moves one level up in menu selections or moves the cursor to the left 
when setting a value. 

 

Up Arrow Displays the previous menu or item. 

 

Down Arrow Displays the next menu or item. 

 

OK Selects or executes the option or function displayed on the screen. 
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Symbol Name Description 

 

Return Navigates up one menu level. 

 

Power Saver Indicates the Energy Saver status. Controls exit from Energy Saver 
Mode. 

 

Stop Stops the current operation. 

 

Clear All Clears the current settings for print, copy, scan, or fax job to the 
default settings. 

 

Redial/Pause 

Available on 
WorkCentre 6015N/NI 
Color Multifunction 
Printer only. 

Recalls the last fax number used or inserts pauses in fax numbers. 

 

Speed Dial 

Available on 
WorkCentre 6015N/NI 
Color Multifunction 
Printer only. 

Allows you to access directories of group or individual fax telephone 
numbers. 
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System Menus 

This section includes: 

 Information Pages ........................................................................................................................................................... 26 

 Billing Meters ..................................................................................................................................................................... 26 

 Admin Menu ...................................................................................................................................................................... 28 

 Default Settings Menu ................................................................................................................................................... 35 

 Tray Settings ...................................................................................................................................................................... 37 

 Panel Language ................................................................................................................................................................ 37 

To access the control panel system menus, press the System button. 
 

Menu Functions 

Information Pages Allows you to print various reports and lists. For details, see Information Pages on page 26. 

Billing Meters Displays the printed paper counts on the control panel. For details, see Billing Meters on 
page 26. 

Admin Menu Set up administrative options: 

 Fax Book: Create or delete address book entries. 

 Network: Configure the network settings for the printer. 

Available on WorkCentre 6015N/NI Color Multifunction Printer only. 

 Fax Settings: Configure default fax settings. 

Available on WorkCentre 6015N/NI Color Multifunction Printer only. 

 System Setup: Configure system settings, such as the Alarm and Power Saver Timer. 

 Maintenance: Reset default settings or adjust color registration, bias transfer roller, and 
fuser temperature. 

 Secure Settings: Set printer security settings. 

 Scan to Email: Enables and disables the ability to edit the From field. 

 USB Setup: Enable or disable the USB port. 
 

Note: For details, see Admin Menu on page 28. 
 

Defaults Settings Allows you to define default settings. For details, see: 

 Copy Defaults on page 35 

 Scan Defaults on page 36 

 Fax Defaults on page 36 

 Print from USB Defaults on page 37 

Tray Settings Allows you to define the size and type of paper loaded in each tray. 

Panel Language Allows you to select the language that appears on the control panel. 
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Information Pages 

Use the Information Pages to print various reports and lists. 
 

Report or List Contents 

System Settings Printer status, including hardware configuration and network information. Print this report 
to verify network information and to check page count. 

Panel Settings Prints settings results for the printer, including default settings, tray settings, network 
setup, fax settings, and system settings. 

Job History Information on previous printing jobs, including the date, time, job type, input port, 
document name, output color, paper size, number of pages, number of sheets, and results. 
The status of a maximum of 20 jobs can be printed on the Job History Report. 

Error History Information about System Fail and Paper Jam errors. 

Demo Page A sample document for checking the printer performance. 

Protocol Monitor 

Available on 
WorkCentre 6015N/NI 
Color Multifunction 
Printer only. 

Information about the previous fax job to help you determine fax protocol problems. 

Address Book 

Available on 
WorkCentre 6015N/NI 
Color Multifunction 
Printer only. 

A list of individual and group email entries. 

Fax Activity 

Available on 
WorkCentre 6015N/NI 
Color Multifunction 
Printer only. 

A list of faxes sent and received by job number, remote station, start time, duration, pages, 
mode, contents, and results. 
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Billing Meters 

The Meter Readings menu shows the number of processed print jobs. The meter is divided according to 
the color mode. You cannot reset the meter readings; they track the total number of pages printed for the 
life of the printer. 
 

Item Description 

Total Impressions The total number of pages printed. 

Color Impressions The total number of pages printed in color. 

Black Impressions The total number of pages printed in black and white. 
 

See also:  

Checking Page Counts on page 163 
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Admin Menu 

This section includes: 

 Fax Book .............................................................................................................................................................................. 28 

 Network ............................................................................................................................................................................... 28 

 Fax Settings ........................................................................................................................................................................ 30 

 System Setup ..................................................................................................................................................................... 31 

 Maintenance ...................................................................................................................................................................... 32 

 Secure Settings ................................................................................................................................................................. 33 

 Scan to Email ..................................................................................................................................................................... 34 

 USB Setup ........................................................................................................................................................................... 34 

Use the Admin Menu to access the configuration settings of the printer. 

 

 

Fax Book 

Use this menu to create, edit, and delete speed dial and group dial numbers. 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

Item Description 

Speed Dial Create, edit, and delete speed dial address book entries. 

Group Dial Create, edit, and delete speed dial group entries. 

 
 

Network 

Use this menu to configure printer settings for jobs sent to the printer through a network port. 
 

Notes: 

 Available on WorkCentre 6015N/NI Color Multifunction Printer only. 

 You cannot select this setting during printing. 

 To activate menu setting changes, restart the printer. After changing settings, turn Off the 
printer, then turn it On again. 
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Wired Network Setup 

This menu provides the selections for setting up the printer for wired Ethernet network connections. 
 

Notes: 

 This menu is the default network menu for the WorkCentre 6015N Color Multifunction Printer. 

 This menu appears on the WorkCentre 6015NI Color Multifunction Printer only when the 
printer is connected to a wired network connection. 

 
 

Item Description 

Ethernet Specifies the Ethernet communication speed and the modes. 

TCP/IP Specifies the TCP/IP settings for the network. 

 IP Mode: Dual Stack or IPv4 Mode. 

 IPv4: Get IP Address, IP Address, Subnet Mask, or Gateway Address 

Protocol Select Enable when using the protocol. Select Disable to make the protocol unavailable. 

 LPR: The default setting is Enable. 

 Port9100: The default setting is Enable. 

 WSD: The default setting is Enable. 

 SNMP: The default setting is Enable. 

 Email Alerts: The default setting is Enable. 

 CentreWare Internet Services: The default setting is Enable. 

 LLTD: The default setting is Enable. 

 Bonjour (mDNS): The default setting is Enable. 

Initialize NVM Initializes network data stored in non-volatile memory. After executing this function and 
restarting the printer, all network settings are reset to their default values. 

 
 

Wireless Network Setup 

This menu provides the selections for setting up the printer for wireless network connections. 
 

Note: This menu appears on the WorkCentre 6015NI Color Multifunction Printer when the printer is 
not connected to a wired network connection. 

 
 

Item Description 

Status Displays the status of the wireless network connection. 

Wireless Setup Specifies the method used for setting up the wireless connection: 

 Manual Setup 

 WPS 

Reset Wireless Resets the wireless network settings to the default settings. 

TCP/IP Specifies the TCP/IP settings for the network. 

 IP Mode: Dual Stack or IPv4 Mode. 

 IPv4: Get IP Address, IP Address, Subnet Mask, or Gateway Address 
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Item Description 

Protocol Select Enable when using the protocol. Select Disable to make the protocol unavailable. 

 LPR: The default setting is Enable. 

 Port9100: The default setting is Enable. 

 WSD: The default setting is Enable. 

 SNMP: The default setting is Enable. 

 Email Alerts: The default setting is Enable. 

 CentreWare Internet Services: The default setting is Enable. 

 LLTD: The default setting is Enable. 

 Bonjour (mDNS): The default setting is Enable. 

Initialize NVM Initializes network data stored in non-volatile memory. After executing this function and 
restarting the printer, all network settings are reset to their default values. 

 
 

Fax Settings 

Use this menu to specify fax settings. 
 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
  

Item Description 

Ans Select Specifies the receiving mode: 

 TEL Mode: Automatic fax reception is turned Off. You can receive a fax by picking up 
the handset of the external phone, then pressing the remote receive code. You can also 
set OnHook to On to start the Fax after you hear fax tones from the remote device. 

 FAX Mode: Automatically receives faxes. 

 TEL/FAX Mode: When the printer receives an incoming fax, the external telephone 
rings for the time specified by Auto Ans, then the printer automatically receives the 
fax. If the incoming data is not a fax, the printer beeps. 

 Ans/FAX Mode: The printer can share one telephone line with an answering machine. 
In this mode, the printer monitors the fax signal and picks up the line if there are fax 
tones. If the phone communication in your country is serial, this mode is not available. 

 DRPD Mode: Before using the Distinctive Ring Pattern Detection (DRPD) option, 
distinctive ring service must be installed on your telephone line by the telephone 
company. After the telephone company provides a separate number with a distinctive 
ring pattern, configure the fax setup to monitor for that specific ring pattern. 

Auto Answer Fax 
When FAX Mode is enabled, specifies how long the printer waits before answering 
an incoming call. Specify values from 0–255 seconds. 

Auto Ans. TEL/FAX When TEL/FAX Mode is enabled, specifies how long the printer waits before answering an 
incoming call. Specify values from 0–255 seconds. 

Auto Ans. Ans/FAX When Ans/FAX Mode is enabled, specifies how long the printer waits before answering an 
incoming call. Specify values from 0–255 seconds. 

Line Monitor Specifies the volume of the external phone. 

Ring Tone Volume Specifies the ring volume for incoming faxes. 
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Item Description 

Line Type Specifies the default line type: PSTN or PBX. 

Dialing Type Specifies the dialing type. 

Interval Timer Specifies the interval timer from 3–255 seconds. 

Number of Redial Specifies the number of attempts made to redial a fax number from 0–9. 

Redial Delay Specifies the interval between redial attempts from 1–15 minutes. 

Junk Fax Filter When set to On, accepts incoming faxes only from numbers registered in the Address 
Book. 

Remote Receive When set to On, you can elect to receive a fax by pressing the remote receive code on the 
external telephone. Press the remote receive code after you pick up the telephone 
handset. 

Remote Rcv Tone Specifies the tone in two digits from 00–99, when Remote Receive is set to On. 

Send Header When set to On, each outgoing fax includes a header, including the company name, fax 
number, and the date and time the fax was sent. When set to Off, no header information 
is included in the outgoing faxes. 
 

Note: Many countries have fax regulations that require Send Headers in each outgoing 
fax. The regulations specify the information that must be included in the header. 

 

Company Name Specifies the sender name that is recorded in the sender report. 

Your Fax Number Specifies your telephone number, which is printed at the top of each page sent from your 
printer. 

Fax Cover Page When set to On, automatically prints a fax cover page. When set to Off, does not print a 
fax cover page. 

DRPD Pattern Specifies a distinctive ring pattern for use with DRPD service. Your telephone company 
specifies the DRPD Patterns. 

Prefix Dial Specifies if you want to add the prefix number when you send a fax. 

Prefix Dial Num Specifies the prefix dial number, up to five digits. This number dials before any auto dial 
number is started. 

Discard Size Specifies if the printer discards any excess data at the bottom of the page. 

ECM If Error Correction Mode (ECM) is set to On, it attempts to correct errors in the fax 
transmission from problems, such as a noisy telephone line. The default setting is On. 

Extel Hook Threshold Specifies the threshold value for the external telephone. 

Modem Speed Specifies the fax modem speed. 

Fax Activity Turns Auto Print On or Off. 

Fax Transmit Specifies the fax transmit mode. 

Fax Broadcast Specifies the fax broadcast mode. 

Country Specifies the country in which the fax is installed. 
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System Setup 

Use this menu to configure general settings of the printer. For example, time to Energy Saver mode, 
alarm settings, and so on. 
 

Item Description 

Power Saver Timer Specifies the transitional time for Energy Saver Modes 1 and 2. 

 Energy Saver Mode 1 (Low Power): 5–60 min. The default setting is 60 minutes. 

 Energy Saver Mode 2 (Sleep): 1–60 min. The default setting is 1 minute. 

For details, see Energy Saver Mode on page 38. 

Auto Reset Specifies the time the printer waits for further control panel input before resetting the 
Copy, Scan, or Fax settings and returning to standby mode. 

Fault Timeout You can cancel a printing process when a fault occurs while printing. Set the time until the 
print job is canceled: 

 On: Specifies the amount of time that the printer waits for additional data before it 
cancels the job. The default setting is 60 seconds. 

 Off: Cannot cancel. 

Job Timeout You can cancel a printing process when it fails to print after a specified amount of time. 
Set the time until the print job is canceled: 

 On: Specifies the amount of time that the printer waits before it cancels the job. The 
default setting is 30 seconds. 

 Off: Cannot cancel. 

Clock Settings Specifies the date and time, and the format of the settings: 

 Set Date and Time. 

 Date Format: Select yy/mm/dd, mm/dd/yy, or dd/mm/yy. 

 Time Format: Select 12H or 24H format. 

 Time Zone: Allows you to set your time zone by geographic region. 

Alert Tone Specifies what prompts an alarm when an error occurs in the printer, and sets the sound 
volume to Off, Min, Middle, or Max: 

 Panel Select Tone: The default setting is Off. 

 Panel Alert Tone: The default setting is Off. 

 Auto Clear Alert: The default setting is Off. 

 Job Tone: The default setting is Middle. 

 Alert Tone: The default setting is Middle. 

 Out of Paper: The default setting is Middle. 

 All Tones: The default setting is Off. 

mm/inch Set the units for the custom paper size to millimeters or inches. 

 Millimeter (mm): The paper size is displayed in millimeters. The default setting is mm. 

 Inch ("): The paper size is displayed in inches. 

Low Toner Alert Msg Turns the Low Toner alert message On or Off. 

Power On Wizard Turns the Power On Wizard On or Off. 
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Maintenance 

Use this menu to find firmware information, make adjustments, and reset defaults. 
 

Item Description 

F/W Version Displays the latest firmware version. 

Adjust Paper Type Adjusts the paper type settings to match the paper loaded in the paper tray. 

Adjust BTR Specifies the bias transfer roller (BTR) voltage for printing on the selected paper type. 

Adjust Fuser Specifies the optimum Fusing Unit voltage for printing on the selected paper type. 

Auto Regi Adjust Adjusts the color registration automatically. The default setting is On. 

Adjust ColorRegi Corrects the color registration. 

For details, see Color Registration on page 157. 

Clean Developer Rotates the developer motors and stirs the toner cartridges to clear old toner from the 
developers. 

Toner Refresh Rotates the developer and stirs the toner in the selected color developer. 

BTR Refresh Specifies when to execute a routine to refresh the BTR to prevent curling and improve 
paper separation. 

Initialize NVM Initializes the settings stored in the non-volatile memory (NVM) except for the network 
settings. The NVM stores the printer settings even after the power is turned off. After 
executing this function and restarting the printer, all the menu settings are reset to their 
default values. 
 

Note: You cannot select this setting during printing. 
 

Adjust Altitude Adjusts the altitude of the printer to obtain optimal printing results. 
 
 

Secure Settings 

Use this menu for controlling access to printer features. 
 

Item Description 

Panel Lock When enabled, access to the Admin Menu requires a password. For details, see Changing 
the Panel Lock Password on page 142. 

Service Lock Specifies if a function is unlocked and available to everyone, locked from everyone, or 
password locked, requiring a password for access: 

 Copy 

 Fax 

Available on WorkCentre 6015N/NI Color Multifunction Printer only. 

 Scan 

 Print from USB 
 

Note: Panel Lock must be enabled before setting the service locks. 
 

Secure Receive Turns Secure Receive Set On or Off. 
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Scan to Email 

Use this menu to enable and disable the ability to edit the From field when an image is scanned to an 
email address. 
 

Item Description 

Edit From Field Enables or disables the edit From field function. 
 
 

USB Setup 

Use this menu to configure the USB port. 
 

Item Description 

Port Status Enables or disables the USB port. 
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Default Settings Menu 

This section includes: 

 Copy Defaults .................................................................................................................................................................... 35 

 Scan Defaults .................................................................................................................................................................... 36 

 Fax Defaults ....................................................................................................................................................................... 36 

 Print from USB Defaults ................................................................................................................................................ 37 

Use the Default Settings menu to set default behaviors for Copy, Scan, Fax, and Print from USB functions. 

 

 

Copy Defaults 

Use this menu to set default copying behaviors. For details, see Selecting the Default Copy Settings on 
page 101. 
 

Item Description 

Color Specifies Black and White or Color output. 

Collated Turns collation On or Off. 

Reduce/Enlarge Reduces or enlarges the copies. 

Document Size Specifies the size of the original. 

Document Type Specifies the type of the original. 

Lighten/Darken Lightens or darkens the output. 

Sharpness Specifies the sharpness of the copies. 

Auto Exposure Turns Auto Exposure On or Off when copying. Auto Exposure suppresses the document 
background of off-white colored paper and show-through when copying 2-sided thin 
paper. 

Color Balance Red Adjusts the red levels of your copies. 

Color Balance Green Adjusts the green levels of your copies. 

Color Balance Blue Adjusts the blue levels of your copies. 

Gray Balance Adjusts the gray balance of the copies to neutral gray. 

N-up Use to copy two original page images onto one side of a sheet of paper: 

 Off 

 Auto (Autoscale) 

 ID Card Copy 

 Manual (Manual Scale) 

Margin Top/Bottom Turns On or Off the copy margins for the top and bottom of the page. 

Margin Left/Right Turns On or Off the copy margins for the left and right of the page. 

Margin Middle Turns On or Off the copy margins for the middle of the page. Use to create a gutter in the 
middle of the page when you print using the N-up feature. 
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Scan Defaults 

Use this menu to set default scanning behaviors. For details, see Adjusting Scanning Settings on 
page 119. 
 

Item Description 

Scan to Network Selects the scan destination: Computer (Network) or Server (FTP). 

File Format Selects the file type of the scanned image. 

Color Specifies Black and White or Color output. 

Color Button Set Adjusts the Color Mode settings: 

 B&W button: Black and White or Grayscale 

 Color Button: Color or Color (Photo) 

Resolution Selects the scan resolution. 

Document Size Specifies the size of the original. 

Lighten/Darken Lightens or darkens the output. 

Sharpness Specifies the sharpness of the scanned images. 

Auto Exposure Turns Auto Exposure On or Off when copying. Auto Exposure suppresses the document 
background of off-white colored paper and show-through when copying 2-sided thin 
paper. 

Margin Top/Bottom Turns On or Off the copy margins for the top and bottom of the page. 

Margin Left/Right Turns On or Off the copy margins for the left and right of the page. 

Margin Middle Turns On or Off the copy margins for the middle of the page. Use to create a gutter in the 
middle of the page when you print using the N-up feature. 

TIFF File Format Sets the TIFF file format: TIFF V6 or TTN2. 

Image Compression Specifies the amount of image compression: Lower, Normal, or Higher. 

Max Email Size Sets limits on the size of attachments that can be emailed from 50–16384 KB. 
 
 

Fax Defaults 

Use this menu to set default faxing behaviors. For details, see Changing the Default Fax Job Settings on 
page 139. 
 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

Item Description 

Resolution Specifies the resolution of the fax. 

Document Type Specifies if the document is a text or photo document. 

Lighten/Darken Lightens or darkens the output. 

Delayed Start Specifies the time delay before sending a fax job, up to 23 hours and 59 minutes. 
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Print from USB Defaults 

Use this menu to set default behaviors for printing from USB. 
 

Item Description 

Layout Specifies the layout options. 
 
 

Tray Settings 

Tray Settings configures the paper size and paper type settings for the main paper tray. If the type of 
paper that is loaded is different from the setting, print quality can be reduced or paper jams can occur. If 
the size of the paper that is loaded is different from the tray setting, it can cause a mismatch error. 
Specify the correct paper type and size. 
 

Item Description 

Paper Size Specifies the paper size and orientation for the main tray. 

For details, see Supported Paper on page 72, and Setting Paper Types and Sizes on page 
79. 

Paper Type Specifies the type of paper loaded in the main tray. 

For details, see Supported Paper on page 72, and Setting Paper Types and Sizes on page 
79. 

Display Screen Turn On to display the message that prompts you to set the paper size and type every 
time you load paper in the tray. The default setting is Off. 

 
 

Panel Language 

Panel Language allows you to set the language that appears on the control panel display. 
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Energy Saver Mode 

This section includes: 

 Setting the Power Saver Timer.................................................................................................................................... 38 

 Exiting Energy Saver Mode .......................................................................................................................................... 38 

You can set the time the printer spends idle in ready mode before it automatically transitions to a lower 
power level. You can also turn off the automatic transition. 

 

 

Setting the Power Saver Timer 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select System Setup, press the arrow buttons, then press OK. 

4. At Power Saver Timer, press OK. 

5. Press the arrow buttons to select one of the following: 

 Power Saver Mode 1: Reduces power consumption to 15 W or less when the printer is left idle. 
Set the timer from 5–60 minutes. The default setting is 60. 

 Power Saver Mode 2: Disables control panel and all sensors after the printer enters Mode 1. 
Reduces power consumption to 7 W or less. Set the timer from 1–60 minutes. The default 
setting is 1. 

6. Press OK. 

7. To select the desired time, press the arrow buttons, then press OK to save the changes. 

8. To return to Ready, press the Return button four times. 
 

Exiting Energy Saver Mode 

The printer automatically cancels Energy Saver mode when it receives data from a connected computer. 

To exit Energy Saver mode manually, press the Power Saver button on the control panel. 
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Administration Features 

This section includes: 

 Information Pages ........................................................................................................................................................... 39 

 CentreWare Internet Services ..................................................................................................................................... 39 
 

 

Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 
 

System Settings Page 

The System Settings page lists printer information such as default settings, installed options, network 
settings including IP address, and font settings. Use the information on this page to help you configure 
network settings for your printer, and to view page counts and system settings. 

To print the System Settings page: 

1. On the printer control panel, press the System button. 

2. At Information Pages, press OK. 

3. Select System Settings using the arrow buttons. 

4. Press OK. 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 
 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

CentreWare Internet Services requires: 

 A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 
environments. 

 TCP/IP and CentreWare Internet Services enabled on the printer. 

 A network-connected computer with a Web browser that supports JavaScript. 
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Accessing CentreWare Internet Services 

At your computer, open a Web browser, type the IP address of the printer in the address field, then press 
Enter or Return. 

If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Quick Use Guide Packaged with the printer. 

Video Tutorials www.xerox.com/office/WC6015docs  

Recommended Media List United States: www.xerox.com/paper  

Europe: www.xerox.com/europaper  

Technical support information for your printer; includes 
online Technical Support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/WC6015support  

Information Pages Print from the control panel menu. 

Order supplies for your printer www.xerox.com/office/WC6015supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, and 
customized features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer Registration www.xerox.com/office/register  

Xerox
®

 Direct online store www.direct.xerox.com/  
 
 

Xerox® Welcome Center 

If you need assistance during or after printer installation, visit the Xerox® website for online solutions and 
support at www.xerox.com/office/worldcontacts. 

If you require further assistance, contact the experts at the Xerox® Welcome Center. If a local 
representative telephone number was provided during printer installation, record the telephone number 
in the following space. 

#_________________________________ 

Xerox® Canada Welcome Center: 1-800-93-XEROX (1-800-939-3769) 

If you need additional help using your printer: 

1. Refer to this User Guide. 

2. Contact the Key Operator. 

3. Visit our customer website at www.xerox.com/office/WC6015support. 
  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=rmlna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=rmleu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=order&Language=English
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The Welcome Center wants to know the following information: 

 The nature of the problem. 

 The serial number of the printer. 

 The fault code. 

 The name and location of your company. 
 

Locating the Serial Number 

You need the printer serial number to order supplies or to contact Xerox for assistance. The serial number 
is located on a tag on the rear door of the printer. The serial number also appears in the System Settings 
Page. To print the System Settings Page: 

1. On the printer control panel, press the System button. 

2. At Information Pages, press OK. 

3. Select System Settings using the arrow buttons. 

4. Press OK. 
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This chapter includes: 

 Installation and Setup Overview ................................................................................................................................ 44 

 Selecting a Location for the Printer........................................................................................................................... 45 

 Connecting the Printer ................................................................................................................................................... 46 

 Configuring Network Settings ..................................................................................................................................... 52 

 Setting the Date and Time ........................................................................................................................................... 58 

 Installing the Software .................................................................................................................................................. 59 

 Setting Up Scanning ....................................................................................................................................................... 64 
 

See also:  

Installation Guide packaged with your printer. 

Online Support Assistant at www.xerox.com/office/WC6015support  
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the driver software and utilities on your computer. 

You can connect to your printer directly from your computer using USB, or connect over a network using 
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables 
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet 
connection because it is typically faster than a USB connection, and it provides access to CentreWare 
Internet Services. 
 

Note: If the Software and Documentation disc is not available, you can download the latest drivers 
from www.xerox.com/office/WC6015drivers. 

  

See also:  

Selecting a Location for the Printer on page 45 

Choosing a Connection Method on page 46 

Connecting the Printer on page 46 

Configuring Network Settings on page 52 

Installing the Software on page 59 
 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=driver&Language=English
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Selecting a Location for the Printer 

1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 15–85%. 
 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the 
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the 
weight for your printer configuration, see Physical Specifications on page 191. 

After positioning the printer, you are ready to connect it to the power source and computer or network. 
 

See also:  

Total Space Requirements on page 191 

Clearance Requirements on page 191 
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Connecting the Printer 

This section includes: 

 Selecting a Connection Method ................................................................................................................................. 46 

 Connecting to a Wired Network ................................................................................................................................. 47 

 Connecting to a Wireless Network ............................................................................................................................ 47 

 Connecting to a Computer Using USB ..................................................................................................................... 51 

 Connecting to a Telephone Line ................................................................................................................................ 51 
 

 

Selecting a Connection Method 

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you 
select depends on how your computer is connected to the network. A USB connection is a direct 
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a 
network connection, it is important to understand how your computer is connected to the network. For 
details, see About TCP/IP and IP Addresses on page 52. 
 

Note: Hardware and cabling requirements vary for the different connection methods. Routers, 
network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your 
printer and must be purchased separately. 

 

 Network: If your computer is connected to an office network or home network, use an Ethernet cable 
to connect the printer to the network. You cannot connect the printer directly to the computer. It 
must be connected through a router or hub. An Ethernet network can be used for one or more 
computers and supports many printers and systems simultaneously. Ethernet connection is typically 
faster than USB and allows you direct access to the settings of the printer using CentreWare Internet 
Services. 

 Wireless Network: If your computer includes a wireless router or wireless access point, you can 
connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network connection 
is typically faster than USB and allows direct access to the setting of the printer using CentreWare 
Internet Services. 

 USB: If you connect the printer to one computer and do not have a network, use a USB connection. A 
USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In 
addition, a USB connection does not provide access to CentreWare Internet Services. 

 Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated 
telephone line.  
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Connecting to a Wired Network 
 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

To connect the printer to a wired network: 

1. Ensure that the printer is turned off. 

2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use an 
Ethernet hub or router, and two or more Ethernet cables. Connect the computer to the hub or router 
with one cable, then connect the printer to the hub or router with the second cable. Connect to any 
port on the hub or router except the uplink port. 

3. Attach the power cord, then plug in the printer and turn it on. 

4. Set or automatically discover the network IP address of the printer. For details, see Assigning the IP 
Address of the Printer on page 53. 

 

Connecting to a Wireless Network 
 

Note: Available on WorkCentre 6015NI Color Multifunction Printer only. 
 

A wireless local area network (LAN) provides the means to connect two or more devices in a LAN without 
a physical connection. The printer can connect to a wireless LAN that includes a wireless router or wireless 
access point. Before connecting the printer to a wireless network, the wireless router must be configured 
with a service set identifier (SSID), a passphrase, and security protocols. 
 

Resetting Wireless Settings 

If the printer was previously installed in a wireless network environment, it could retain setup and 
configuration information.  

To prevent the printer from trying to connect to the previous network, perform the following steps: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select Wireless, press the arrow buttons, then press OK. 

4. To select Reset Wireless, press the arrow buttons, then press OK. 

5. To select Yes, press the arrow buttons, then press OK. 
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Connecting to a Network With a Wi-Fi Protected Setup-Compliant Router 

Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network. The WPS protocols 
allow you with no wireless network experience to set up devices in a secure wireless network. With a 
WPS-certified router, you can use tools in the router and the printer to connect the printer to the network. 
In order to use the tools, the wireless router must be configured properly and must be compliant with the 
WPS. 

 Push Button Connection (PBC) is the easiest way to connect the printer to a wireless network. It 
automatically connects when you push a button on the router and on the printer. After the router 
and printer exchange information, the printer accepts the security and configuration information 
from the router and connects to the network. The PBC is a moderately secure way to connect the 
printer to the network. You do not need to enter any information to make the network connection. 

 PIN (Personal Identification Number) automatically connects the printer to wireless router by using 
a common PIN. The printer generates and prints a PIN for use in the setup process. When you enter 
the PIN into the router, the router broadcasts network information using the PIN. When both devices 
recognize the PIN, the router provides the security and configuration information to the printer, 
which uses it to connect to the network. 

To connect to a WPS wireless network using the PBC method: 
 

Note: The wireless router must be connected and properly configured for the network before you 
install the printer. 

 

1. Push the PBC button on the wireless router. 

The router begins broadcasting setup information for 120 seconds. 
 

Note: If the wireless router does not have a physical PBC button, use your computer to push the 
virtual button in the router control panel. For details, see your router documentation. 

 

2. On the printer control panel, press the System button. 

3. To select Network, press the arrow buttons, then press OK. 

4. To select Wireless Setup, press the arrow buttons, then press OK. 

5. To select WPS, press the arrow buttons, then press OK. 

6. To select Push Button Control, press the arrow buttons, then press OK. 

7. To select Yes, press the arrow buttons, then press OK. 

The printer communicates with the router to resolve setup and configuration information. The counter 
starts counting down from 100. When the printer has the correct information, it connects to the router 
and restarts with the proper setup and configuration information. 

To connect to a WPS wireless network using the PIN method: 
 

Note: The wireless router must be connected and properly configured for the network before you 
install the printer. 

 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select Network, press the arrow buttons, then press OK. 
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4. To select Wireless Setup, press the arrow buttons, then press OK. 

5. To select WPS, press the arrow buttons, then press OK. 

6. To select PIN Code, press the arrow buttons, then press OK. 

7. To select Print PIN, press the arrow buttons, then Press OK. 

The PIN is printed at the top of the PIN Code Print. 

8. At your computer, open the router control panel and select Add WPS Client. 
 

Note: For details, see your router documentation. 
 

9. Select PIN Method. 
 

Note: The following steps can vary with different router manufacturers. 
 

10. Enter the PIN from the PIN Code Print into the Client PIN field, then click Next. 

11. On the printer control panel, press the System button. 

12. To select Admin Menu, press the arrow buttons, then press OK. 

13. To select Network, press the arrow buttons, then press OK. 

14. To select Wireless Setup, press the arrow buttons, then press OK. 

15. To select WPS, press the arrow buttons, then press OK. 

16. To select PIN Code, press the arrow buttons, then press OK. 

17. To select Start Configuration, press the arrow buttons, then press OK. 

The printer communicates with the router to resolve setup and configuration information. The counter 
starts counting down from 100. When the printer has the correct information, it connects to the router 
and restarts with the proper setup and configuration information. 
 

Connecting to a Wireless Network Manually 

When connecting to a wireless network that does not include a WPS-compliant router, you must set up 
and configure the printer manually. Before starting, you must get the setup and configuration 
information, such as name and passphrase, from the router. After you collect the network information, 
you can set up the printer from the control panel or from CentreWare Internet Services. The easiest 
manual connection is by using CentreWare Internet Services. 

To record the network information from the wireless router: 

1. On your computer, use your Web browser to open the control panel for the wireless router. 

2. Click Wireless Settings. 

3. Record the following information. The network name and passphrase are case sensitive. Ensure that 
you record them exactly as they appear in the wireless router control panel. 

 Name (SSID) 

 Security Options (Encryption Type) 

 Passphrase 
 

Note: The wireless router must be connected and properly configured for the network before you 
install the printer. For details, see your router documentation. 
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To connect to a wireless network manually from the printer control panel: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select Network, press the arrow buttons, then press OK. 

4. To select Wireless Setup, press the arrow buttons, then press OK. 

5. To select Manual Setup, press the arrow buttons, then press OK. 

6. At Enter Network (SSID), enter the name (SSID) of the network, then press OK. 

7. To select Infrastructure or AdHoc, press the arrow buttons, then press OK. 
 

Note: Infrastructure provides the greatest selection of security options. AdHoc provides only WEP 
encryption in most networks. 

 

8. To select the Encryption Type, use the arrow buttons, then press OK. 

9. Enter the passphrase using the keypad. 

Use multiple keystrokes to select each character and character case or number. To erase a character, 
press the Clear button for each character starting from the right. 

10. Press OK. 

If the printer does not connect to the network within 90 seconds, check the network information and 
try again. 

To connect to a wireless network manually using CentreWare Internet Services: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

2. Click the Properties button. 

3. In the Properties pane at the left of the window, click Wireless Lan. 

4. In the SSID field, enter the network name (SSID). 

5. To select the Network Type, use the drop-down menu to select Infrastructure or AdHoc. 
 

Note: Infrastructure provides the greatest selection of security options. AdHoc provides only WEP 
encryption in most networks. 

 

6. To select Encryption, use the drop-down list to select the match the security option of the router. 

7. To remove the five dots in the Passphrase field, select them, then press Backspace. 

8. Enter the network passphrase in the Passphrase field. 

9. To remove the five dots in the Re-enter Passphrase field, select them, then press Backspace. 

10. Enter the network passphrase in the Re-enter Passphrase field. 

11. Click Save Changes. 
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12. Disconnect the Ethernet cable from the printer. 

13. Turn off the printer, then turn it on again. 

When the printer restarts, it uses the information from CentreWare Internet Services to connect with the 
wireless router. Print a System Settings Page to check the connection information. If the printer does not 
successfully connect with the wireless network, check your network information and try again. 
 

Connecting to a Computer Using USB 

To use USB, you must have Windows XP SP1 and later, Windows Server 2003 and later, or Macintosh OS X 
version 10.5 and later. 

To connect the printer to the computer using a USB cable: 

1. Ensure that the printer is turned off. 

2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer. 

3. Attach the power cord and then plug in the printer and turn it on. 

4. Connect the A end of the USB cable to the USB Port on the computer. 

5. When the Windows Found New Hardware Wizard appears, cancel it. 

6. You are ready to install the print drivers. For details, see Installing the Software on page 59. 
 

Connecting to a Telephone Line 

1. Ensure that the printer is turned off. 

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on the 
back of the printer. 

3. Connect the other end of the RJ11 cable to an operating telephone line. 

4. Enable and configure the Fax functions. 

For details, see Changing the Default Fax Job Settings on page 139. 
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Configuring Network Settings 

This section includes: 

 About TCP/IP and IP Addresses ................................................................................................................................. 52 

 Assigning the IP Address of the Printer ................................................................................................................... 53 

 Setting Up the Fax Header ........................................................................................................................................... 56 

 Enabling the Printer for Scanning .............................................................................................................................. 57 
 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

 

 

About TCP/IP and IP Addresses 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a 
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does 
not require printers or computers to have IP addresses. 

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and 
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically assigns an IP address to every computer and printer on the network that is configured to 
use DHCP. 

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing. 
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Assigning the IP Address of the Printer 

This section includes: 

 Assigning the IP Address Automatically ................................................................................................................. 53 

 Assigning the IP Address Manually ........................................................................................................................... 53 

 Finding the IP Address of the Printer ....................................................................................................................... 55 

 Changing the IP Address Using CentreWare Internet Services...................................................................... 56 

By default, the printer is set to acquire an IP address from the network server using DHCP. Network 
addresses assigned by DHCP are temporary, however. After a specified time, the network could assign a 
new IP address to the printer. If the print driver is set to an IP address that changes periodically, you can 
experience connectivity issues. To avoid problems, or if your network administrator requires a static IP 
address for the printer, you can assign the IP address to the printer. 
 

Note: You can view the IP address of your printer from the the System Settings Page, the printer 
control panel, or CentreWare Internet Services. 

 
 

See also:  

Assigning the IP Address Manually on page 53 

Finding the IP Address of Your Printer on page 55 
 

 

 

Assigning the IP Address Automatically 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. At Network, press OK. 

4. To select TCP/IP, press the Down Arrow button, then press OK. 

5. To select IPv4, press the arrow buttons, then press OK. 

6. At Get IP Address, press OK. 

7. To select DHCP/AutoIP, press the arrow buttons, then press OK. 

8. To return to the Ready screen, press Return. 
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Assigning the IP Address Manually 

You can assign a static IP address to your printer from the printer control panel. Once an IP address is 
assigned, you can change it using CentreWare Internet Services. 

To assign a static IP address to the printer, you need the following information: 

 An IP address properly configured for your network 

 The Network Mask address 

 The default Router/Gateway address 

If you are on a network managed by a network administrator, contact your network administrator to 
obtain the network information. 

For a home network using routers or other devices to connect the printer to the network, refer to the 
device instructions on assigning network addresses. The router or device documentation can give you a 
range of acceptable address numbers you can use. It is important that the addresses be similar to the IP 
addresses used by other printers and computers on the network, but not the same. Only the last digit 
must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer 
has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4. 

The router could assign the static IP address of the printer to another computer that obtains its IP 
address dynamically. To avoid having the IP address reassigned, give the printer an address at the higher 
end of the range allowed by the router or device. For example, if your computer has IP address 
192.168.1.2, and your device allows IP addresses to 192.168.1.25, select an address between 
192.168.1.20 and 192.168.1.25. 

In IPv6 network configurations, the IPv6 address is assigned automatically. 

To assign a static IP address to the printer: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select Network, press the arrow buttons, then press OK. 

4. To select TCP/IP, press the Down Arrow button, then press OK. 

5. To select IPv4, press the arrow buttons, then press OK. 

6. At Get IP Address, press OK. 

7. To select Panel, press the arrow buttons, then press OK to enable this option. 

8. To return to the IPv4 menu, press Return once. 

9. To select IP Address, press the arrow buttons, then press OK. 

When undefined, the address is 000.000.000.000. 

10. Set the IP address: 

a. In the first field, press the arrow buttons, or use the alphanumeric keypad, to enter the desired 
number. 

b. To move to the next field, press the Forward Arrow, then enter the desired number. 
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c. Move to the next two fields and enter the desired numbers. 
 

Note: To scroll quickly to a number, press the Up or Down Arrow. To return to a field, press the Back 
Arrow. 

 

d. When finished, press OK to confirm the address. 

11. To return to IP Address, press the Back Arrow once. 

12. To select Network Mask, press the Down Arrow, then press OK. Repeat step 10 to set the Network 
Mask address. 

13. To return to Network Mask, press the Back Arrow once. 

14. To select Gateway Address, press the Down Arrow, then press OK. Repeat step 10 to set the 
Gateway Address. 

15. To return to the Ready screen, press Return. 

16. Print the System Settings Page to verify the new settings. 

You are ready to install software. 
 

See also:  

Online Support Assistant at: www.xerox.com/office/WC6015support  
 
 

Finding the IP Address of the Printer 

To install the print drivers for a network-connected printer, you need the IP address of your printer. You 
also need the IP address to access the settings of your printer through CentreWare Internet Services. You 
can view the IP address of your printer from the System Settings Page or on the printer control panel. 

To print the System Settings Page: 

1. On the printer control panel, press the System button. 

2. At Information Pages, press the OK button. 

3. To select System Settings, press the arrow buttons, then press OK to print the page. 

The IP address of the printer is listed in the Wired Network section of the page. 
 

Note: After the printer has been on for two minutes, print the System Settings Page. The TCP/IP 
address appears in the Network section of the page. If the IP address listed on the page is 0.0.0.0, the 
printer needs more time to acquire an IP address from the DHCP server. Wait two minutes, then print 
the System Settings Page again. 

 

To view the IP address of the printer on the control panel: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select Network, press the arrow buttons, then press OK. 

4. To select TCP/IP, press the arrow buttons, then press OK. 

5. To select IPv4, press the arrow buttons, then press OK. 

6. To select IP Address, press the arrow buttons, then press OK. 

The IP address of the printer appears on the IP Address screen. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Changing the IP Address Using CentreWare Internet Services 

To change the IP address of the printer using CentreWare Internet Services: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. Click the Properties link. 

If the Protocols link is not expanded under Properties, scroll to the Protocols link and expand it. 

3. Click TCP/IP. 

4. In the IPv4 section of the page, make the desired changes. For example, to change the way the 
printer acquires the IP address, in the Get IP Address field, select a method from the drop-down list. 

5. After changing the address information, scroll to the bottom of the page and click Save Changes. 
 

Setting Up the Fax Header 

It is unlawful to send a message from a fax machine without the proper Fax Send Header information. 
The following information must appear on the first transmitted page, or in the top or bottom margin of 
each transmitted page: 

 Identity of the business or individual sending the fax 

 Telephone number of the sending machine 

 Date and time of the transmission 

To set the required Fax Send Header information at the control panel: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select Fax Setting, press the arrow buttons, then press OK. 

4. Identify the business or individual sending the fax: 

a. To select Company Name, press the arrow button, then press OK. 

b. Use the alphanumeric keypad to enter the name of your company, then press OK. 

5. Identify the telephone number of the sending fax machine: 

a. To select Your Fax Number, press the arrow button, then press OK. 

b. Use the alphanumeric keypad to enter the telephone number of the printer, then press OK. 
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6. Identify the country: 

a. To select Country, press the arrow button, then press OK. 

b. To select your country name, press the arrow button, then press OK. 

c. At the Restart System (Are You Sure?) prompt, press the Down Arrow to select Yes, then press 
OK. 

7. To return to the Ready screen, press Return. 
 

See also:  

Setting the Date and Time on page 58 

CentreWare Internet Services on page 39 

Faxing on page 127 
 
 

Adding Fax Numbers and Email Addresses to the Address Book 

If the printer is connected to a network, you can add fax numbers and email addresses to the printer 
address book using CentreWare Internet Services. 

If the printer is connected with a USB cable, you can add fax numbers and email addresses to the printer 
address book using the Address Book Editor. 

For details, see Adding an Individual Fax Address Book Entry on page 132, Creating a Fax Group on page 
134, and Editing Address Book Fax Groups on page 135. 

For more information, see Faxing on page 127. 
 

Enabling the Printer for Scanning 

If the printer is connected to a network, you can scan to an FTP address, an email address, or a shared 
folder on your computer. First you must set up scanning in CentreWare Internet Services. For details, see 
CentreWare Internet Services on page 39. 

If the printer is connected with a USB cable, you can scan to a folder on your computer, or scan into an 
application. First you must install the scan drivers and the Express Scan Manager utility. 
 

Note: If your printer is connected using the USB cable, you cannot scan to an email address or a 
network location, such as a shared folder on your computer. 

For details, see Scanning Setup Overview on page 64. 
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Setting the Date and Time 

Set the date and time on the printer before using it to send fax transmissions. It is unlawful to send a fax 
without the proper Fax Send Header information. For details, see Enabling the Printer for Faxing on page 
56. 

To set the date and time: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. To select System Setup, press the arrow buttons, then press OK. 

4. To select Clock Settings, press the arrow buttons, then press OK. 

5. To select Set Date, press the arrow buttons, then press OK. 

6. To set the month, press the arrow buttons, then press the Right Arrow button. 

7. To set the day, press the arrow buttons, then press the Right Arrow button. 

8. To set the year, press the arrow buttons, then press OK. 

9. To select Set Time, press the arrow buttons, then press OK. 

10. To set the hour, press the arrow buttons, then press the Right Arrow button. If the time format is set 
to 12H, ensure that you set the hour correctly for AM or PM. 

11. To set the minutes, press the arrow buttons, then press OK. 

12. To select Date Format, press the arrow buttons, then press OK. 

13. To select the date format to use, press the arrow buttons, then press OK. 

14. To select Time Format, press the arrow buttons, then press OK. 

15. To select 12H or 24H, press the arrow buttons, then press OK. 

16. To select Time Zone, press the arrow buttons, then press OK. 

17. To select the Greenwich Mean Time (GMT) offset for your time zone, press the arrow buttons, then 
press OK. For example, the GMT offset for Pacific Standard time is -08.00. 

18. To return to the Ready screen, press Return. 
 

Note: You can also set the date and time using CentreWare Internet Services. 
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Installing the Software 

This section includes: 

 Operating System Requirements ............................................................................................................................... 59 

 Available Print Drivers .................................................................................................................................................... 59 

 Installing the Print Drivers for a Windows Network Printer ............................................................................. 59 

 Installing the Print Drivers for a Windows USB Printer ...................................................................................... 61 

 Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later ...................................... 62 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If you 
cannot find the IP address, see Finding the IP Address of the Printer on page 55. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/WC6015drivers. 

Operating System Requirements 

 Windows XP SP1 and later, or Windows Server 2003 and later 

 Macintosh OS X version 10.4 or later 
 

Available Print Drivers 

To access special printing options, use a Xerox® print driver. The following print drivers are available for 
various operating systems. To download the latest drivers, go to www.xerox.com/office/WC6015drivers. 
 

Print Driver Source Description 

Windows GDI Driver Software and 
Documentation disc 
and Web 

The GDI, or raster, driver is recommended to take full 
advantage of the custom features of your printer. 

Mac OS X version 10.5 and 
later Driver 

Software and 
Documentation disc 
and Web 

This GDI driver enables printing from a Macintosh OS X 
version 10.5 and later operating system. 

 
 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=driver&Language=English
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Installing the Print Drivers for a Windows Network Printer 

1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click the Network Installation button. 

3. At the bottom of the Driver Installation window, click Language. 

4. Select your language, then click OK. 

5. Click Next. 

6. Click I accept the terms to accept the agreement, then click Next. 

7. In the Discovered Printers list, select your WorkCentre 6015 printer, then click Next. 
 

Note: When installing drivers for a network printer, if you do not see your printer in the list, click the IP 
Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your 
printer, then click Search to locate your printer. If you do not know the IP address of the printer, see 
Finding the IP Address of Your Printer on page 55. 

 

8. Click Next to start the installation. 

9. When the installation is complete, at the Enter Printer Settings screen, select the following: 

 Share this printer with other computers on the network (optional) 

 Set this printer as default for printing (optional) 

 Set this printer as default for scanning ensures that the scanner works properly with your 
computer. 

 

Note: If Set this printer as default scanning is not selected when the drivers are installed, the scanner 
will not be available for network scanning. 

 

 FAX Driver ensures that the fax works properly with your computer. 

10. Click Next. 

11. In the Software and Documentation window, clear the check box for any of the options you do not 
want to install. 

12. Click Install. 

13. At the InstallShield Wizard, click Yes to restart your computer, then click Finish. 

14. At the Product Registration screen, select your country from the list, then click Next. Complete the 
registration form and submit it. 

 

Notes:The following applications are installed on your computer with the print driver: 

 PrintingScout 

 Launcher 

 Express Scan Manager 

 Address Book Editor: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

See also:  

Online Support Assistant at: www.xerox.com/office/WC6015support  
 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Installing the Print Drivers for a Windows USB Printer 

1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click the Personal Installation (USB) button. 

3. At the bottom of the Driver Installation window, click Language. 

4. Select your language, then click OK. 

5. Click Next. 

6. Click I accept the terms to accept the agreement, then click Next. 

7. At the InstallShield Wizard, click Yes to restart your computer, then click Finish. 

8. At the Product Registration screen, select your country from the list, then click Next. Complete the 
registration form and submit it. 

 

Notes:The following applications are installed on your computer with the print driver: 

 PrintingScout 

 Launcher 

 Express Scan Manager 

 Address Book Editor: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

See also:  

Online Support Assistant at: www.xerox.com/office/WC6015support  
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later 

This section includes: 

 Installing the Print Driver .............................................................................................................................................. 62 

 Adding the Printer ............................................................................................................................................................ 62 

 Utilities ................................................................................................................................................................................. 63 

To access all features of the printer, you must: 

1. Install the print driver. 

2. Add the printer. 
 

Note: Before installing drivers, verify that the printer is plugged in, turned on, and connected to an 
active network or by USB. Ensure that the printer is receiving network information by monitoring the 
LEDs on the back of the printer near the Ethernet cable connection. When the printer is connected to 
a functioning network and receiving traffic, the link LED is green, and its amber traffic LED flashes 
rapidly. 

 

Installing the Print Driver 

1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
 

Note: If the Software and Documentation disc is not available, you can download the latest drivers 
from www.xerox.com/office/WC6015drivers. 

 

2. Double-click WorkCentre 6015 Installer. 

3. At the Introduction installer window, click Continue. 

4. Read the warning notice, then click Continue. 

5. Read the license agreement, click Continue, then click Agree. 

6. Click Install. 

7. If prompted, enter your password, then click OK. 

8. Click Continue Installation. 

When the driver is finished installing, click Logout to complete the installation and restart your 
computer. 

 

Adding the Printer 

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your 
printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection. 

To add the printer using Bonjour: 

1. From the computer Applications folder or from the dock, open System Preferences. 

2. Click Print & Fax. 

The list of printers appears on the left of the window. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=driver&Language=English
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3. Click the plus button (+) under the list of printers. 

4. Click the Default icon at the top of the window. 

5. Select your printer from the list and click Add. 
 

Note: If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable 
is connected properly. 

 

To add the printer by specifying the IP address: 

1. From the computer Applications folder or from the dock, open System Preferences. 

2. Click Print & Fax. 

The list of printers appears on the left of the window. 

3. Click the plus button (+) under the list of printers. 

4. Click IP. 

5. From the Protocol drop-down menu, select the protocol. 

6. In the Address field, enter the IP address of the printer. 

7. In the Name field, enter a name for the printer. 

8. From the Print Using drop-down list, choose Select a driver to use. 

9. Select the print driver for your printer model from the list. 

10. Click Add. 

Now you can print and scan. For details, see Printing on page 71 and Scanning on page 105. 
 

See also:  

Online Support Assistant at: www.xerox.com/office/WC6015support  
 
 

Utilities 

The Address Book Editor and Express Scan Manager are installed automatically when you install the scan 
driver. For details, see Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later on 
page 62. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Setting Up Scanning 

This section includes: 

 Scanning Setup Overview ............................................................................................................................................. 64 

 Setting Up Scanning to a Shared Folder on Your Computer ........................................................................... 65 

 Setting Up Scanning to an FTP Server ..................................................................................................................... 68 

 Setting Up Scanning to an Email Address .............................................................................................................. 68 

 Setting Up Scanning With USB .................................................................................................................................. 69 
 

See also:  

Scanning on page 105 
 

 

 

Scanning Setup Overview 

If the printer is connected to a network, it is enabled for scanning. Before you can scan, you must do the 
following: 

 If you are scanning to a shared folder on your computer, share the folder, set the correct permissions, 
and add the folder as an Address Book entry in CentreWare Internet Services. 

 If you are scanning to an FTP server, add the FTP server and set the correct folder permissions as an 
Address Book entry in CentreWare Internet Services. 

 If you are scanning to an email address, configure the email server in CentreWare Internet Services. 

If the printer is connected using a USB cable, you cannot scan to an email address or a network location. 
You can scan to a folder on your computer, or scan into an application after installing the scan drivers and 
the Express Scan Manager utility. 

For details, see Installing the Software on page 59. 
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Setting Up Scanning to a Shared Folder on Your Computer 

This section includes: 

 Sharing a Folder Using Windows ............................................................................................................................... 65 

 Sharing the Folder Using Macintosh OS X Version 10.5 and Later ............................................................... 65 

 Adding the Folder as an Address Book Entry Using the Address Book Editor ........................................... 67 

 Adding the Folder as an Address Book Entry Using CentreWare Internet Services ............................... 67 

Before you can scan to a shared folder, you must share the folder, then add the folder as an Address Book 
entry in CentreWare Internet Services. 

For details, see CentreWare Internet Services on page 39. 

 

 

Sharing a Folder Using Windows 

1. Open Windows Explorer. 

2. Right-click the folder you want to share and select Properties. 

3. Click the Sharing tab, then click Share this folder. 

4. Click the Permissions button. 

5. Select the Everyone group, and verify that all permissions are enabled. 

6. Click OK. 
 

Note: Remember the Share name for later use. 
 

7. Click OK again. 

8. Open a DOS Command Prompt window: 

a. On the Start menu, select Run. 

b. In the Open field, type cmd and click OK. 

9. Type ipconfig, then press Enter. 

10. Record the IP address. 

11. Close the DOS Command Prompt window. 

The folder is ready. Now add the folder as an Address Book entry. For details, see Adding the Folder as an 
Address Book Entry Using CentreWare Internet Services on page 67. 
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Sharing the Folder Using Macintosh OS X Version 10.5 and Later 

To enable a folder on your Macintosh computer for network sharing: 

1. From the Apple menu, select System Preferences. 

2. From the View menu, select Sharing. 

3. From the Services list, select File Sharing. 

4. Click the plus icon (+) below the Shared Folders field. A folder list appears. 

5. Select the folder you want to share on the network, then click Add. 

6. Select the folder you want to share from the Shared Folders window. 

7. From the Users list, click Everyone. 

8. From the list to the right of the Users window, use the arrow buttons to select user privileges for the 
shared folder. 

9. Click the Options button. 

10. Do one or more of the following: 

 Select Share files and folders using AFP to share this folder with other Macintosh computers. 

 Select Share files and folders using FTP to share this folder with computer connected to an FTP 
server. 

 Select Share files and folders using SMB to share this folder with Windows computers. 

11. Select the On check box to the left of File Sharing in the Service pane. 

The folder and its contents are shared with network users. 

12. Close the Sharing window. 
 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and its subfolders. 

The folder is ready. Now add the folder as an Address Book entry. For details, see Adding the Folder as an 
Address Book Entry Using CentreWare Internet Services on page 67. 
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Adding the Folder as an Address Book Entry Using the Address Book Editor 

1. On your computer select Start > All Programs > Xerox Office Printing > WorkCentre 6015N-NI > 
Address Book Editor. 

2. Double-click the Server icon under the Printer Address Book in the left navigation pane. 

3. Enter a name in the Name field to identify this access to the shared file on your computer. 

4. Select Computer (SMB) as the Server Type. 

5. Click the Computer Settings Wizard button. 

6. Click the Browse button. 

7. Browse to the shared folder that you created on your computer. 

8. Click OK, then click Next. 

9. Enter a Login Name, which is your computer user name, for the printer to use to access the shared 
folder. 

10. Enter, then confirm, your computer login password for the printer to use to access the shared folder. 

11. Click Next, then click Finish. At the Server Address window, click OK. 

The new server appears in the Server pane at the top of the window. 

For details, see Setting Up Scanning to a Shared Folder on Your Computer on page 65. 
 

Adding the Folder as an Address Book Entry Using CentreWare Internet Services 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. Click Address Book. 

3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book. 

4. Click Add next to any empty field, and enter the following information: 

 Name: Enter the name that you want to appear in the Address Book. 

 Network Type: Select Computer (SMB). 

 Host Address: Enter the IP address of your computer. 

 Port Number: Enter the default port number for SMB, 139, or select a number from the range 
provided. 

 Login Name: Enter your computer user name. 

 Login Password: Enter your computer login password. 

 Re-enter Password: Enter your login password again. 
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 Name of Shared Directory: Enter a name for the directory or folder. For example, if you want 
the scanned files to go in a folder named scans type /scans. 

 Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the 
scanned files to go in a folder named colorscans inside the scans folder, type /colorscans. 

5. Click Save Changes. 

Now you can scan to a folder on your computer. For details, see Setting Up Scanning to a Shared Folder 
on Your Computer on page 65. 
 

Setting Up Scanning to an FTP Server 
 

Note: Before setting up scanning to an FTP Server, it must have the proper software installed and be 
configured with shared folders for each user. 

 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. In CentreWare Internet Services, click Address Book. 

3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book. 

4. Click Add next to any blank field, and enter the following information: 

 Name: Enter the name that you want to appear in the Address Book. 

 Network Type: Select Server (FTP). 

 Host Address: Enter the IP address or DNS name of the FTP server. 

 Port Number: Enter the default port number for FTP, 21, or select a number from the range 
provided. 

 Login Name: Enter a valid login name for your FTP server. 

 Password: Enter a valid password for your FTP server. 

 Re-enter Password: Enter the password again. 

 Name of Shared Directory: Enter a name for the directory or folder. For example, if you want 
the scanned files to go in a folder named scans type /scans. 

 Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the 
scanned files to go in a folder named colorscans inside the scans folder, type /colorscans. 

5. Click Save Changes. A new address book entry is created. 

Now you can scan to the FTP server. 
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Setting Up Scanning to an Email Address 

Before you can scan to an email address, you must configure the printer to communicate with your SMTP 
email server. 

To configure the SMTP server settings: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. Click Properties. 

3. Under Protocols in the left pane, click Email Server. 

4. Enter the following information: 

 SMTP Server (IP Address or DNS Name): Enter the IP address or DNS name of the SMTP 
server. 

 SMTP Port: Enter the default port number for SMTP, 25, or select a number from the range 
provided. 

5. Select an Authentication Type. 
 

Note: The authentication type needs to be compatible with your SMTP server. 
 

6. Enter a valid SMTP Login Name for the SMTP Server. 

7. Enter a valid password for the SMTP server. 

8. Re-enter the password. 

9. Scroll down and click Save Changes. 
 

Note: Contact your Internet service provider or system administrator to obtain your SMTP server 
name or IP address. Some Internet service providers require authentication. Ensure that you confirm 
the authentication type, login, and password. 

 

Now you can scan to an email address. For details, see Setting Up Scanning to an Email Address on 
page 68. 
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Setting Up Scanning With USB 

If the printer is connected using a USB cable, you cannot scan to an email address or a network location. 
You can scan to a folder on your computer, or scan into an application after installing the scan drivers and 
the Express Scan Manager utility. For details, see Installing the Software on page 59. 
 

Setting Up Scanning to a Folder on Your Computer With USB 

1. Start Express Scan Manager: 

 Windows: Click Start > Programs > Xerox. Select your printer from the list. Double-click Express 
Scan Manager. 

 Macintosh: Navigate to Applications > Xerox. Select your printer from the list. Double-click 
Express Scan Manager. 

2. Click OK to accept the default Destination Path folder, or click Browse to navigate to another folder. 

3. Press OK. 

Now you can scan to a folder on your computer. For details, see Scanning to a Folder on USB Connected 
Computer on page 109. 
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This chapter includes: 
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Supported Paper 

This section includes: 

 Recommended Media .................................................................................................................................................... 72 

 Ordering Paper .................................................................................................................................................................. 72 

 General Paper Loading Guidelines ............................................................................................................................ 72 

 Paper That Can Damage Your Printer ...................................................................................................................... 73 

 Paper Storage Guidelines .............................................................................................................................................. 73 

 Supported Standard Paper Sizes ................................................................................................................................ 74 

 Supported Custom Paper Sizes ................................................................................................................................... 74 

 Supported Paper Types and Weights ....................................................................................................................... 74 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
to ensure the best print quality and to avoid jams. 

For best results, use Xerox® paper and media recommended for your printer. 

Recommended Media 

A list of paper and media recommended for your printer is available at: 

 www.xerox.com/paper Recommended Media List (United States) 

 www.xerox.com/europaper Recommended Media List (Europe) 
 

Ordering Paper 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/WC6015supplies. 
 
 

General Paper Loading Guidelines 

 Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 

 Adjust the paper guides to fit the paper size. 

 Fan paper before loading it in the paper tray. 

 If excessive jams occur, use paper or other approved media from a new package. 

 Use only recommended Xerox® transparencies. Print quality could vary with other transparencies. 

 Do not print on label media once a label has been removed from a sheet. 

 Use only paper envelopes. Print envelopes 1-sided only. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=rmlna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=rmleu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=order&Language=English
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage your 
printer. Do not use the following: 

 Rough or porous paper 

 Inkjet paper 

 Non-laser glossy or coated paper 

 Paper that has been photocopied 

 Paper that has been folded or wrinkled 

 Paper with cutouts or perforations 

 Stapled paper 

 Envelopes with windows, metal clasps, side seams, or adhesives with release strips 

 Padded envelopes 

 Plastic media 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 

 Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

 Reduce the exposure of paper to strong lights for long periods of time. 

 Maintain constant temperatures and relative humidity. 

 Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 
moisture. 

 Store paper flat, either on pallets, cartons, shelves, or in cabinets. 

 Avoid food or drinks in the area where paper is stored or handled. 

 Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored 
paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain. 

 Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Standard Paper Sizes 
 

European Standard Sizes North American Standard Sizes 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 

A5 (148 x 210 mm, 8.3 x 5.8 in.) 

JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 

C5 envelope (162 x 229 mm, 6.4 x 9 in.) 

DL envelope (110 x 220 mm, 4.33 x 8.66 in.) 

Executive (184 x 267 mm, 7.25 x 10.5 in.) 

Letter (216 x 279 mm, 8.5 x 11 in.) 

Legal (216 x 356 mm, 8.5 x 14 in.) 

216 x 330 mm, 8.5 x 13 in. 

Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.) 

No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.) 
 
 

Supported Custom Paper Sizes 

 Width: 76.2–216 mm (3–8.5 in.) 

 Length: 127–355.6 mm (5–14 in.) 
 

Supported Paper Types and Weights 

The printer supports the following paper types with paper weights from 60–163 g/m² (16 lb. Plain–60 lb. 
Cover): 

 Plain 

 Bond 

 Lightweight Cardstock 

 Lightweight Glossy Cardstock 

 Labels 

 Recycled 

 Envelope 

 Plain S2 

 Bond S2 

 Lightweight Cardstock S2 

 Lightweight Glossy Cardstock S2 

 Recycled S2 
 

Note: S2 refers to the second side of a manual 2-sided print job. 
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Loading Paper 

This section includes: 

 Loading Paper in the Main Tray ................................................................................................................................. 75 

 Loading Paper in the Bypass Tray ............................................................................................................................. 78 

 Setting Paper Types, Paper Sizes, and Display Screen ....................................................................................... 79 
 

 

Loading Paper in the Main Tray 

The main tray holds up to 150 sheets of paper. 
 

Note: To avoid paper jams, do not remove the paper cover while printing is in progress. 
 

1. Open the front cover. 

 
2. Pull the slide bar forward until it stops. 
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3. Pull the length guide forward until it stops. 

 
4. Move the width guides to the edges of the tray. 

 
5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
6. Load the paper into the tray with the top edge going into the printer and the print side up. 
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7. Adjust the width guides until they touch the edges of the paper. 

 
8. Push in the length guides and slide bar until they stop. 

 
 

Note: Depending on the size of the paper, first push the slide bar toward the printer until it stops. 
Pinch the length guide and slide it in until it touches the paper edge. 

 

 
9. Place the bypass tray on the main tray, then align the tabs with the marks. 
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10. If the paper you loaded is not plain, set the correct paper type and size at the control panel and in 
your print driver. For details, see Setting Paper Types, Paper Sizes, and Display Screen on page 79. 

 

Note: If you are printing on custom size paper, define the custom size in the printer properties before 
printing. 

 
 

Loading Paper in the Bypass Tray 

The bypass tray holds up to 10 pages of paper. Paper loaded in the bypass tray is used before paper 
loaded in the main tray. 
 

Note: To avoid paper jams, do not remove the paper cover while printing is in progress. 
 

1. Open the front cover. 

 
2. Place the paper cover on the main tray and align the tabs with the marks on the tray. 

  
3. Move the width guides to the edges of the tray. 
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
5. Load the paper into the tray with the top edge going into the printer and the print side up. 

 
6. Adjust the width guides until they touch the edges of the paper. 

 
7. If the paper you loaded is different from the paper in the main tray, set the correct paper type and 

size. Ensure that you change the paper type and size at the control panel and in your print driver 
software. For details, see Setting Paper Types, Size, and Display Screen on page 79. 

 

Note: If you are printing on custom size paper, define the custom size in the printer properties before 
printing. For details, see Defining Custom Paper Sizes on page 86. 
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Setting Paper Types, Paper Sizes, and Display Screen 

After loading paper in the main tray or bypass tray, the printer prompts you to set the paper type and size 
on the control panel. If you want the control panel message to appear when you load the main tray, turn 
Display Screen on. 
 

 CAUTION: To prevent print-quality problems, ensure that paper type settings match the paper type 
loaded in the tray. 

 

To set the paper size or type for paper in a tray: 

1. On the printer control panel, press the System button. 

2. To select Tray Settings, press the arrow buttons, then press OK. 

3. At Main Tray, press OK. 

4. To select Paper Size, Paper Type, or Display Screen, press the arrow buttons, then press OK. 

5. To select the desired paper setting, press the arrow buttons, then press OK. 

6. To return to the Ready screen, press Return. 
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Selecting Printing Options 

This section includes: 

 Selecting Printing Defaults in Windows .................................................................................................................. 81 

 Selecting Printing Defaults in Windows for a Shared Network Printer ........................................................ 81 

 Selecting Printing Options for an Individual Job in Windows ......................................................................... 82 

 Selecting Printing Options for Macintosh ............................................................................................................... 82 

Print driver settings override control panel settings when you print using the print driver software on 
your computer. 

Selecting Printing Defaults in Windows 

Use these instructions to set print driver defaults for the print driver software installed on your computer. 
You can override the default settings for an individual print job when printing from an application. You 
can set default settings for a network printer that apply to that printer for anyone who accesses it over 
the network. For details, see Selecting Printing Defaults in Windows for a Shared Network Printer on page 
81. 

To set the default settings: 

1. Navigate to the list of printers on your computer: 

 For Windows XP SP1 and later, click Start > Settings > Printers and Faxes. 

 For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 

 For Windows Server 2003 and later, click Start > Settings > Printers. 

 For Windows 7, click Start > Devices and Printers. 

2. In the Printers folder, right-click the name of your print driver and select Printing Preferences. 

3. Make selections on the print driver tabs as desired, then click OK. 
 

Note: For more information about Windows print driver options, click Help in the Printing Preferences 
dialog box. 

 
 

Selecting Printing Defaults in Windows for a Shared Network Printer 

If the printer is shared on a network, you can set printing defaults that apply to anyone who accesses it 
from the network. You can override network-level defaults through the driver settings on your computer. 

1. Navigate to the list of printers on your computer: 

 For Windows XP SP1 and later, click Start > Settings > Printers and Faxes. 

 For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 

 For Windows Server 2003 and later, click Start > Settings > Printers. 

 For Windows 7, click Start > Devices and Printers. 

2. In the Printers folder, right-click the name of your print driver and select Properties. 
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3. In the printer Properties dialog box, click the Advanced tab. 

4. On the Advanced tab, click Printing Defaults. 

5. Make your selections on the driver tabs as desired, then click Apply. 

6. Click OK to save your selections. 
 

Selecting Printing Options for an Individual Job in Windows 

To use special printing options for a particular job, change the print driver settings in the application 
before sending the job to the printer. 
 

Note: The print driver includes online help with more information on selecting printing options. To 
access help from any print driver dialog box, click Help. 

 

To select printing options: 

1. With the desired document or graphic open in your application, open the Print dialog box. For most 
software applications, click File > Print or press CTRL+P. 

2. Select your printer, then click Properties to open the print driver dialog box. 

3. Make selections from the driver tabs as desired, beginning with settings in the Paper/Output tab. 

4. Click OK in the Properties window, then click OK in the Print window. 
 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 

1. With the document open in your application, click File > Print. 

2. Select your printer from the list. 

3. Select Xerox® Features from the Copies & Pages menu. 

4. Select the desired printing options from the drop-down lists. 

5. Click Print to send the job to the printer. 
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Printing Envelopes 

This section includes: 

 Guidelines for Printing Envelopes .............................................................................................................................. 83 

 Loading Envelopes in the Trays .................................................................................................................................. 83 

 Specifying the Main Tray Settings for Printing Envelopes ............................................................................... 85 

 Printing Envelopes From an Application ................................................................................................................. 85 

You can print envelopes from either the main tray or the bypass tray. To print from either tray, select the 
correct envelope size in the control panel Main Tray settings and in the print driver. Print driver settings 
override control panel settings when you print using the print driver software on your computer. 
 

 CAUTION: Never use self-stick envelopes or envelopes with windows. They can damage the printer 
and cause jams. 

 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 

 

 

Guidelines for Printing Envelopes 

 Print quality depends on the quality and construction of the envelopes. Try another envelope brand 
if you do not get desired results. 

 Maintain constant temperatures and relative humidity. 

 Store unused envelopes in their packaging to avoid the excess moisture and dryness which can affect 
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

 Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on 
top of them. 

 In the print driver software, select Envelope as the paper type. 

 Do not use padded envelopes. Use envelopes that lie flat on a surface. 

 Do not use envelopes with heat activated glue. 

 Do not use envelopes with press and seal flaps. 

 Use only paper envelopes. 

 Do not use envelopes with windows or metal clasps. 
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Loading Envelopes in the Trays 

Use the following procedure to load envelopes in the main tray and bypass tray: 

1. Slide open the paper guides. 

2. Do one of the following: 

 Insert No. 10, DL, or Monarch envelopes with the print side up, flaps closed and facing down, 
and the flap side to the right. 

 
 

Note: To prevent wrinkling on No. 10, DL, or Monarch envelopes, load them with the print side up, 
flaps open and facing away from the printer. 

 

 
 

Note: When you load envelopes long-edge feed, ensure that you specify landscape orientation in the 
print driver. 

 

 Insert C5 envelopes with the print side up, flaps open and facing away from the printer. 

 
3. Adjust the paper guides so they rest lightly against the edges of the envelopes. 
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Specifying the Main Tray Settings for Printing Envelopes 

1. On the printer control panel, press the System button. 

2. To select Tray Settings, press the arrow buttons, then press OK. 

3. At Main Tray, press OK. 

4. Select Paper Type using the arrow buttons, then press OK. 

5. Select Envelope using the arrow buttons, then press OK. 

6. Press the Return button once. 

7. Select Paper Size using the arrow buttons, then press OK. 

8. Select the desired envelope size using the arrow buttons, then press OK. 

9. To return to the Ready screen, press Return. 
 

Printing Envelopes From an Application 

1. With the desired document or graphic open in your application, open the Print dialog box. For most 
software applications, click File > Print or press CTRL+P. 

2. Select your printer, then click Properties to open the print driver dialog box. 

3. Make selections from the driver tabs as desired, beginning with settings in the Paper/Output tab. 

4. Click OK in the Properties window, then click OK in the Print window. 
 

Note: For illustrated instructions for printing on envelopes, refer to the Envelope/Paper Setup 
Navigator on the Paper/Output tab of the print driver. 
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Using Custom Paper Sizes 

This section includes: 

 Defining Custom Paper Sizes ....................................................................................................................................... 86 

 Printing on Custom Paper Sizes .................................................................................................................................. 87 

The WorkCentre 6015 Color Multifunction Printer prints on custom paper sizes that are within the 
minimum and maximum size range supported by the printer. 

 

 

Defining Custom Paper Sizes 

To print custom paper sizes, define the custom width and length of the paper in the print driver software 
and on the printer control panel. When setting the paper size, ensure that you specify the same size as the 
paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override control 
panel settings when you print using the print driver software on your computer. 
 

Defining a Custom Paper Size for Windows 

You can save up to 20 custom paper sizes in the Windows print driver. Save each custom size with a 
unique name and the dimensions are retained until you change them. 

1. Navigate to the list of printers on your computer: 

 For Windows XP SP1 and later, click Start > Settings > Printers and Faxes. 

 For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 

 For Windows Server 2003 and later, click Start > Settings > Printers. 

 For Windows 7, click Start > Devices and Printers. 

2. From the Printers and Faxes window, select a printer, right-click the printer, and select Properties. 
 

Notes: 

 For Windows 7, in the Devices and Printers window, right click the printer, and select Printer 
Properties from the middle of the drop-down list. 

 For Windows 7, you must have an Administrator Account to select Custom Settings in the 
print driver. 

 

3. In the Properties dialog box, click the Configuration tab, then click Custom Paper Size. 

4. In the Custom Paper Size Settings dialog box, select the units of measurement to use. 

5. In the Custom Size Settings section, specify the size for the short edge and the long edge of the 
paper. 

6. Select the Name the Paper Size check box, type a name in the Paper Name dialog box, then click 
OK. 

7. In the Properties dialog box, click OK. 

The custom size appears in the Paper Size list in the print driver Properties window. 
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Defining a Custom Paper Size for Macintosh 

1. In the application you are printing from, select File > Page Setup. 

2. From the Format For drop-down list, select the printer. 

3. From the Paper Size drop-down list, select Manage Custom Sizes. 

4. In the Custom Paper Sizes window, click plus (+) to add the new custom size. 

5. For the custom paper size, enter the width and height. 

6. In the Non-Printable Area drop-down list, select the printer. 

7. Double-click untitled, then type a name for the new custom size. 

8. Click OK to close the Custom Paper Sizes window. 

9. Click OK to close the Page Setup window. 

The new custom size is available in the Paper Size drop-down list of the print driver and in Page 
Setup. 

 

Note: To use the custom paper size, select Page Setup, and select the custom size that you created 
from the Paper Size drop-down list. 

 
 

Printing on Custom Paper Sizes 
 

Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer properties 
to define the custom size. For details, see Defining Custom Paper Sizes on page 86. 

 
 

Printing on Custom Paper Size Using Windows 

1. Load the custom-size paper in the tray. For details, see Loading Paper on page 75. 

2. In the application, click File > Print and select your printer. 

3. In the Print dialog box, click Properties. 

4. On the Paper/Output tab, use the Paper Size drop-down list to select the desired custom size. 
 

Note: If you are printing on custom size paper, define the custom size in the printer properties before 
printing. 

 

5. From the Paper Type drop-down list, select the paper type. 

6. Select any other desired options, then click OK. 

7. In the Print dialog box, click OK to start printing. 
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Printing on Custom Paper Size Using Macintosh 

1. Load the custom-size paper. For details, see Loading Paper on page 75. 

2. In the application, click Page Setup. 

3. From the Paper Size drop-down list, select the custom paper size. 

4. Click OK. 

5. In the application, click Print. 

6. Click OK. 
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Printing on Both Sides of the Paper 

This section includes: 

 Setting Up 2-Sided Printing.......................................................................................................................................... 89 

 Loading Paper for Manual 2-Sided Printing ........................................................................................................... 90 

The WorkCentre 6015 Color Multifunction Printer supports manual 2-sided printing. You can set printing 
preferences to print your jobs on both sides of the paper. 

Use 2-Sided Printing to specify the page orientation for the printed output. 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These 
settings override the application page orientation settings. 
 

Portrait Landscape 

 

 
 

 
 

 
 

 

Portrait 

2-Sided Print 

Portrait 

2-Sided Print, Flip on Short 
Edge 

Landscape 

2-Sided Print 

Landscape 

2-Sided Print, Flip on Short 
Edge 

 

 

 

Setting Up 2-Sided Printing 

To set up manual 2-sided printing: 

1. From the File menu, select Print. 

2. Select the printer from the Select Printer list, then click Properties. 

3. From the Duplex window on the Paper/Output tab, select Flip on Long Edge or Flip on Short Edge. 

4. Select the Paper Size and Paper Type to match the paper you are using. 

5. To close the Printing Preferences dialog box, click OK. 

6. To start printing, click Print. 
 

Note: When you start manual 2-sided printing, the Manual Duplex Setup window appears. Do not 
close the window until you have completed the 2-sided printing. Once the window is closed, it cannot 
be reopened. 
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Loading Paper for Manual 2-Sided Printing 

For manual 2-sided printing, the back sides of the pages are printed first in reverse order. For a six-page 
document, the pages are printed page 6, page 4, and then page 2. Once the even pages are printed, the 
paper is reloaded. The odd pages are printed page 1, page 3, and then page 5. 

1. Load the paper to print the even pages. 
 

Note: Load letterhead into the main tray with the printed side down and the top going into the 
printer. 

 

 
Once the even pages have printed, the Error indicator lights and the Ready indicator flashes. 

2. Remove the printed pages from the output tray and reload them into the main tray without rotating 
or flipping the pages. The unprinted sides of the pages are facing up. 

 
3. Press OK. 

The odd pages are printed, page 1, page 3, then page 5. 
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Printing From a USB Flash Drive 

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. The print from 
USB function supports .jpg, .pdf, and .tiff file formats. 
 

Notes: 

 Before pressing the Print button or inserting the USB Flash drive, press the Power Saver button, 
then wait until the Power Saver indicator turns off. 

 You can print files stored using the Scan to USB Memory feature. File types created from other 
sources can fail to print properly. 

 

To print from the USB Flash drive: 

1. Insert the USB Flash Drive into the USB memory port on the printer. 

2. To select Print From, press the arrow buttons then press the OK button. 
 

Note: If the USB Flash drive was already in the USB memory port, press the Print button. 
 

3. To select a file, press the arrow buttons, then press OK. 

4. Do one of the following: 

 To print the file page-size, press the arrow buttons to select Auto On. 

 To print the file the original size, press the arrow buttons to select Auto Off. 

If necessary, press the arrow buttons to highlight the file name. 

5. Press the green Start button on the control panel. 
 

Note: For best results, save files in .jpg format. 
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This chapter includes: 

 Making Copies ................................................................................................................................................................... 94 

 Adjusting Copying Options .......................................................................................................................................... 96 

 Changing the Default Copy Settings ...................................................................................................................... 101 

 Limiting Access to Copying ........................................................................................................................................ 103 
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Making Copies 

1. To clear previous control panel copy settings, press the Clear All button. 

2. Load your original documents: 

 Use the document glass for single pages or paper that cannot be fed using the automatic 
document feeder. Lift the automatic document feeder or the document glass cover, then place 
the original face down in the upper left corner of the document glass. 

 
 Use the automatic document feeder for multiple or single pages. Remove any staples and paper 

clips from the pages, then place them face up in the document feeder. Insert originals face up 
with the top of the page entering the feeder first. Adjust the paper guides so they fit against the 
originals. 

 
3. On the control panel, press the Copy button. 

4. Using the control panel keypad, enter the desired number of copies. The number of copies appears 
on the upper right corner of the display. To reset the number of copies to 1, press the Clear All 
button. 

5. To select the copying option you want to change, press the arrow buttons. For details, see Adjusting 
Copying Options on page 96. 

6. Press the Start button. One set of copies prints. 

If you place originals in the automatic document feeder, copying continues until the automatic 
document feeder is empty. 
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Automatic Document Feeder Guidelines 
 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

The automatic document feeder accommodates the following originals: 

 Width: 148–216 mm (4.1–8.5 in.) 

 Length: 210–355.6 mm (8.3–14 in.) 

 Weight: 60–105 g/m² (16–28 lb. Bond) 

Follow these guidelines when loading originals into the automatic document feeder: 

 Load originals face up so that the top of the document enters the feeder first. 

 Place only loose sheets of paper in the automatic document feeder. 

 Adjust the paper guides so that they fit against the originals. 

 Insert paper in the automatic document feeder only when ink on the paper is dry. 

 Do not load originals above the MAX fill line. 
 

Document Glass Guidelines 

The document glass accommodates original sizes up to 216 x 297 mm (8.5 x 11.7 in.). Use the document 
glass rather than the automatic document feeder to copy or scan the following types of originals: 

 Paper with paper clips or staples attached 

 Paper with wrinkles, curls, folds, tears, or notches 

 Coated or carbonless paper or items other than paper such as cloth or metal 

 Envelopes 

 Books 
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Adjusting Copying Options 

This section includes: 

 Basic Settings .................................................................................................................................................................... 97 

 Image-Quality Settings.................................................................................................................................................. 98 

 Image Layout Adjustments ......................................................................................................................................... 99 

 Output Adjustments ..................................................................................................................................................... 100 

You can adjust numerous options for your copy jobs, specify characteristics of the original documents, 
and customize the output. For details, see Basic Copying on page 94. 

You can also modify the default settings for many options. For details, see Selecting Default Copy 
Settings on page 101. 
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Basic Settings 

This section includes: 

 Selecting Color or Black and White Copies ............................................................................................................. 97 

 Specifying the Original Size.......................................................................................................................................... 97 

 Specifying the Original Document Type ................................................................................................................. 97 
 

 

Selecting Color or Black and White Copies 

If the original document contains color, you can create copies in full color or in black and white. The color 
mode indicators light to show the current setting. 

Press the Color Mode button to toggle the selection between color and black and white. 
 

Note: The Color Mode returns to the default setting after the copy job is complete. To modify the 
default setting, see Selecting the Default Copy Settings on page 101. 

 
 

Specifying the Original Size 

1. To select Document Size, press the arrow buttons, then press OK. 

2. Select the document size. 

3. Press OK. 
 

Specifying the Original Document Type 

The scanner optimizes the appearance of the output based on the contents of the original document. 

To specify the type of the original document: 

1. To select Document Type, press the arrow buttons, then press OK. 

2. Select the document type: 

 Text for black and white or colored text. 

 Mixed for both text and photographs, such as magazines or newspapers. This is the default 
setting. 

 Photo for photographs. 

3. Press OK. 
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Image-Quality Settings 

This section includes: 

 Reducing or Enlarging the Image .............................................................................................................................. 98 

 Making the Image Lighter or Darker ........................................................................................................................ 98 

 Adjusting the Sharpness ................................................................................................................................................ 98 

 Setting Auto Exposure .................................................................................................................................................... 99 
 

 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the copied image: 

1. To select Reduce/Enlarge, press the arrow buttons, then press OK. 

2. Do one of the following: 

 To select a preset image size, press the arrow buttons. 

 To set the copy size in increments of 1%, press the arrow buttons or use the keypad to set the 
percentage. The default setting is 100%. 

3. Press OK. 
 

Making the Image Lighter or Darker 

1. To select Lighten/Darken, press the arrow buttons, then press OK. 

2. To lighten or darken the image, press the arrow buttons to move the slider. 

3. Press OK. 
 

Adjusting the Sharpness 

1. To select Sharpness, press the arrow buttons, then press OK. 

2. Select a sharpness setting: 

 Sharpest 

 Sharper 

 Normal 

 Softer 

 Softest 

The default setting is Normal. 

3. Press OK. 
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Setting Auto Exposure 

Paper that is close to white, such as newsprint or parchment, can cause the printer to put toner on the 
entire page. The Auto Exposure setting removes the light background and only prints the image. 

To turn Auto Exposure on or off: 

1. To select Auto Exposure, press the arrow buttons, then press OK. 

2. Select an option: 

 Off 

 On 

The default setting is On. 

3. Press OK. 
 

Image Layout Adjustments 

You can change the following image layout adjustment settings. For details, see: 

 Printing Multiple Pages per Side on page 99 

 Setting the Copy Margins on page 99 
 

Printing Multiple Pages per Side 

You can copy a single page and have it print multiple times onto one or both sides of the paper. The 
printer reduces the pages proportionally to fit. 

To print multiple pages per side: 

1. To select N-Up, press the arrow buttons, then press OK. 

2. Select an option: 

 Off copies one original image onto one side of a page. This is the default setting. 

 Auto copies two original pages, reduces the images, and prints them onto one side of a page. 

 ID Card Copy copies two original size images onto one side of a page. The images are not 
reduced. 

 Manual reduces the two original images as specified in Reduce/Enlarge, and prints them onto 
one side of a page. 

3. Press OK. 
 

Setting Copy Margins 

1. To select the margin you want to change, press the arrow buttons for: 

 Margin Top/Bottom 

 Margin Left/Right 

 Margin Middle 

2. Press OK. 
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3. Adjust the margins from 0.0–2.0 in. using the arrow buttons. 

4. Press OK. 

5. Repeat the steps for other margins, then press the Return button. 
 

Note: The margin left/right settings only apply when copying from the document glass. 
 
 

Output Adjustments 

Collating Copies 

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a 
six-page document, the copies are printed in this order: 

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6 

Uncollated copies print in the following order: 

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6 

To select a collating option: 

1. To select Collated, press the arrow buttons, then press OK. 

2. Select an option: 

 Off turns collation off. 

 On turns collation on. 

 Auto turns collation on. This is the default setting. 

3. Press OK. 
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Changing the Default Copy Settings 

This section includes: 

 Changing the Color Mode ........................................................................................................................................... 101 

 Changing the Auto Exposure Level ......................................................................................................................... 101 

 Changing the Color Balance ...................................................................................................................................... 102 

 Changing the Manual Feed Slot Paper Size ......................................................................................................... 102 

The printer uses the default copy settings on all copy jobs unless you change them for an individual job. 
You can modify the default copy settings. 

To change the default copy settings: 

1. On the control panel, press the System button. 

2. To select Default Settings, press the arrow buttons, then pressOK. 

3. Select Copy Defaults, then press OK. 

4. To select the option you want to change, press the Down Arrow button, then press OK. 

5. Select the desired setting, then press OK to confirm the new setting. 

6. Repeat steps 4 and 5 as needed to change the defaults. 

7. To return to the Ready screen, press Return. 
 

 

Changing the Color Mode 

1. To select Color, press the arrow buttons, then press OK. 

2. Select a color setting: 

 Black & White 

 Color 

3. Press OK. 
 

Changing the Auto Exposure Level 

1. To select Auto Exposure Level, press the arrow buttons, then press OK. 

2. Select an auto exposure setting: 

 Off 

 On 

The default setting is On. 

3. Press OK. 
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Changing the Color Balance 

The Color Balance control allows you to adjust the print color of your printer. Each of the four primary 
colors of red, green, blue, and gray balance, have five density settings. The density settings adjust the 
output based on the level of color saturation. Adjusting the setting negatively lowers the density and 
lightens the output. Adjusting the setting positively increases the density and darkens the output. 
Examples of low density areas include faces and sky. 

To change the color balance: 

1. To select Color Balance, press the arrow buttons, then press OK. 

2. Select the color you want to adjust, then press OK. 

3. To adjust the density setting from -2 through +2, press the arrow buttons. 

4. Press OK. 

5. Select another color and adjust its density, or press the Return button to return to the Ready screen. 
 

Changing the Manual Feed Slot Paper Size 

1. To select Document Size, press the arrow buttons, then press OK. 

2. Select a Document Size. 

3. Press OK. 
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Limiting Access to Copying 

The Copy Lock options limit access to copying by requiring a password to use the Copy function or to 
make color copies. You can also turn off copying. 

To set the copy lock: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

If prompted, enter the four-digit password, then press OK. 

3. Select Secure Settings, then press OK. 

4. Select Service Lock, then press OK. 
 

Note: Panel Lock must be enabled before setting the service locks. For more information, see 
Changing the Panel Lock Password on page 142. 

 

5. Select Copy, then press OK. 

6. Select an option: 

 Unlocked turns off the service lock. 

 Locked turns on the service lock, and turns off the copy function. 

 Password Locked requires a password to use the copy function. Enter a new password, then 
press OK. 

 Color Pass requires a password to make color copies. 

7. Press OK. 
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This chapter includes: 

 Loading Documents for Scanning ........................................................................................................................... 106 

 Scanning to a USB Flash Drive .................................................................................................................................. 108 

 Scanning to a Folder on a USB Connected Computer ..................................................................................... 109 

 Scanning to a Shared Folder on a Network Computer .................................................................................... 110 

 Scanning to an Email Address ................................................................................................................................... 114 

 Scanning to an FTP Server .......................................................................................................................................... 115 

 Scanning Images into an Application on a USB Connected Computer .................................................... 116 

 Adjusting Scanning Settings ...................................................................................................................................... 119 

 Changing the Default Scan Settings ...................................................................................................................... 122 

 Limiting Access to Scanning ...................................................................................................................................... 126 
 

See also:  

Installation and Setup Overview on page 44 
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Loading Documents for Scanning 

Position the original document as shown. 
 

 
 

Document Glass 

Lift the automatic document feeder or 
the document glass cover, then place the 
original face down in the upper left corner 
of the document glass. 

Automatic Document Feeder 

Insert originals face up with the top of the page 
entering the feeder first. Adjust the paper guides so 
they fit against the originals. 

 
 

Automatic Document Feeder Guidelines 
 

Note: Available on WorkCentre 6015N/NI Color Multifunction Printer only. 
 

The automatic document feeder accommodates the following originals: 

 Width: 148–216 mm (4.1–8.5 in.) 

 Length: 210–355.6 mm (8.3–14 in.) 

 Weight: 60–105 g/m² (16–28 lb. Bond) 

Follow these guidelines when loading originals into the automatic document feeder: 

 Load originals face up so that the top of the document enters the feeder first. 

 Place only loose sheets of paper in the automatic document feeder. 

 Adjust the paper guides so that they fit against the originals. 

 Insert paper in the automatic document feeder only when ink on the paper is dry. 

 Do not load originals above the MAX fill line. 
 

  



Scanning 

 

 WorkCentre 6015 Color Multifunction Printer 107 
 User Guide 
 

Document Glass Guidelines 

The document glass accommodates original sizes up to 216 x 297 mm (8.5 x 11.7 in.). Use the document 
glass rather than the automatic document feeder to copy or scan the following types of originals: 

 Paper with paper clips or staples attached 

 Paper with wrinkles, curls, folds, tears, or notches 

 Coated or carbonless paper or items other than paper such as cloth or metal 

 Envelopes 

 Books 
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Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
supports .jpg, .pdf, and .tiff file formats. 
 

Note: Before pressing the Scan button or inserting the USB Flash drive, press the Power Saver button, 
then wait until the Power Saver indicator turns off. 

 

1. Load the original on the document glass or in the automatic document feeder. 

2. Do one of the following: 

 Insert your USB Flash drive in the USB port on the front of the printer, then select Scan to using 
the arrow buttons. 

 Press the Scan button, press the arrow buttons to select Scan to USB Memory, then press OK. 

3. Press OK. 

4. Do one of the following: 

 To save the scanned file directly to the USB Flash drive, select Save to USB Drive, then press OK. 

 To save the scanned file to a folder on the USB Flash drive, press the arrow buttons to navigate 
to the folder, then press OK. 

5. At Save to USB Drive or Save to this folder, press OK. 

6. To select any scanning options you want to change, press the arrow buttons. 

7. To select Scan to, press the arrow buttons. 

8. Press Start to begin the scan. 

9. If the Another Page? prompt appears, select an option: 

 No completes the scanning process. 

 Yes prompts you to place the next page on the document glass. 

10. Select Continue or Cancel the Action. 

11. Press OK. 

The printer scans your images to the folder you specified. 
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Scanning to a Folder on a USB Connected 
Computer 

1. Start Express Scan Manager: 

 Windows: Click Start > Programs > Xerox. Select your printer from the list. Double-click Express 
Scan Manager. 

 Macintosh: Navigate to Applications > Xerox. Select your printer from the list. Double-click 
Express Scan Manager. 

2. Click OK to accept the default Destination Path folder, or click Browse to navigate to another folder. 

3. Press OK. 

4. Load the original on the document glass or in the automatic document feeder. 

5. On the printer control panel, press the Scan button. 

6. To select Scan to Computer (USB), press the arrow buttons, then press OK. 

7. To change any of the options, press the arrow buttons to select the option, then press OK. 

8. To begin the scan, press the arrow buttons to select Scan to, then press Start. 

An Express Scan Manager dialog box opens on your computer to indicate the progress. The printer 
scans your documents to the output destination specified in Express Scan Manager. 
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Scanning to a Shared Folder on a Network 
Computer 

This section includes: 

 Sharing a Folder on a Windows Computer ........................................................................................................... 110 

 Sharing a Folder Using Macintosh OS X Version 10.5 and Later ................................................................. 111 

 Adding a Folder as an Address Book Entry Using CentreWare Internet Services .................................. 111 

 Adding a Folder as an Address Book Entry Using the Address Book Editor ............................................. 112 

 Scanning to a Folder on a Network Computer.................................................................................................... 112 

Before using the printer as a scanner on a network, you must: 

1. Create a shared folder on your computer hard drive. 

2. Create an address using CentreWare Internet Services or the Address Book Editor pointing the 
scanner to the computer. 

 

Note: For more information, see Connecting the Printer on page 46. 
 

 

 

Sharing a Folder on a Windows Computer 

1. Open Windows Explorer. 

2. Right-click the folder you want to share and select Properties. 

3. Click the Sharing tab, then click Share this folder. 

4. Click the Permissions button. 

5. Select the Everyone group, and verify that all permissions are enabled. 

6. Click OK. 
 

Note: Remember the Share name for later use. 
 

7. Click OK again. 
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Sharing a Folder Using Macintosh OS X Version 10.5 and Later 

1. From the Apple menu, select System Preferences. 

2. From the View menu, select Sharing. 

3. From the Services list, select File Sharing. 

4. Click the plus icon (+) below the Shared Folders field. A folder list appears. 

5. Select the folder you want to share on the network, then click Add. 

6. Select the folder you want to share from the Shared Folders window. 

7. From the Users list, click Everyone. 

8. From the list to the right of the Users window, use the arrow buttons to select user privileges for the 
shared folder. 

9. Click the Options button. 

10. Do one or more of the following: 

 Select Share files and folders using AFP to share this folder with other Macintosh computers. 

 Select Share files and folders using FTP to share this folder with computer connected to an FTP 
server. 

 Select Share files and folders using SMB to share this folder with Windows computers. 

11. Select the On check box to the left of File Sharing in the Service pane. 

The folder and its contents are shared with network users. 

12. Close the Sharing window. 
 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and its subfolders. 

 
 

Adding a Folder as an Address Book Entry Using CentreWare Internet 
Services 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. Click Address Book. 

3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book. 

4. Click Add next to any empty field, and enter the following information: 

 Name: Enter the name that you want to appear in the Address Book. 

 Network Type: Select Computer (SMB). 

 Host Address: Enter the IP address of your computer. 

 Port Number: Enter the default port number for SMB, 139, or select a number from the range 
provided. 

 Login Name: Enter your computer user name. 

 Login Password: Enter your computer login password. 

 Re-enter Password: Enter your login password again. 
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 Name of Shared Directory: Enter a name for the directory or folder. For example, if you want 
the scanned files to go in a folder named scans type /scans. 

 Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the 
scanned files to go in a folder named colorscans inside the scans folder, type /colorscans. 

5. Click Save Changes. 
 

Adding a Folder as an Address Book Entry Using the Address Book Editor 

1. On your computer select Start > All Programs > Xerox. 

2. Select your printer from the list. 

3. Click Address Book Editor. 

4. Double-click the Server icon under the Printer Address Book in the left navigation pane. 

5. Enter the following information: 

 Name: Enter the name that you want to appear in the Address Book. 

 Server Type: Select Computer (SMB). 

 Server Name/IP Address: Enter the IP address of your computer. 

 Share Name: Enter a name for the directory or folder. 

 Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the 
scanned files to go in a folder named colorscans inside the scans folder, type /colorscans. 

 Login Name: Enter your computer user name. 

 Login Password: Enter your computer login password. 

 Re-enter Password: Enter your login password again. 

 Port Number: Enter the default port number for SMB, 139, or select a number from the range 
provided. 

6. Click OK. 

The new server appears in the Server pane. 

7. Click File > Save All. 
 

Scanning to a Folder on a Network Computer 

1. On the printer control panel, press the Scan button. 

2. To select Scan to Network, press the arrow buttons, then press the OK button. 

3. At Scan to, press OK. 

4. At Computer (Network), press OK. 

5. To select the shared folder on your computer, press the arrow buttons, then press OK. 

6. To change any other scan settings, press the arrow buttons to select the setting, and make the 
desired changes. For details, see Adjusting Scanning Settings on page 119. 

7. To begin the scan, press the Start button. 

8. If the Another Page? prompt appears, select an option: 

 No completes the scanning process. 

 Yes prompts you to place the next page on the document glass. 
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9. Select Continue or Cancel the Action. 

10. Press OK. 

The printer scans the documents to the shared folder on your computer. 
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Scanning to an Email Address 

Before scanning to an email address, you must set up the printer up with the email server information. For 
details, see Setting Up Scanning to an Email Address on page 68. 

To scan an image and send it to an email address: 

1. On the printer control panel, press the Scan button. 

2. To select Scan to Email, press the arrow buttons, then press OK. 

3. At Email to, press OK. 

4. Select the method for selecting the recipient: 

 Keypad allows you to enter the email address manually. Use the keypad to enter the address. 

 Address Book allows you to select an email address from the Address Book. 

 Email Group allows you to select a group email address from the Address Book. 
 

Note: When using the Address Book, press the arrow buttons to select the address for the desired 
recipient. Press the Forward Arrow button to select TO or BCC. When finished selecting addresses, 
press OK. 

 

5. To begin the scan, press the Start button. 

6. If the Another Page? prompt appears, select an option: 

 No completes the scanning process. 

 Yes prompts you to place the next page on the document glass. 

7. Select Continue or Cancel the Action. 

8. Press OK. 

The printer sends the scanned image as email attachments of the default file type. 
 

See also:  

Adjusting Scanning Settings on page 119 
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Scanning to an FTP Server 

Before using this feature, you must: 

1. Set up an FTP server. 

2. Create an address for the printer to use. You can use CentreWare Internet Services or the Address 
Book Editor. 

To scan to an FTP server: 

1. Load the original on the document glass or in the automatic document feeder. 

2. On the printer control panel, press the Scan button. 

3. To select Scan to Network, press the arrow buttons, then press OK. 

4. At Scan to, press OK. 

5. To select Server (FTP), press the arrow buttons, then press OK. 

6. To select the FTP address, press the arrow buttons, then press OK. 

7. To begin the scan, press the Start button. 

The printer scans the document and places the image on the FTP server. 
 

See also:  

Adjusting Scanning Settings on page 119 
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Scanning Images into an Application on a USB 
Connected Computer 

This section includes: 

 Scanning an Image into an Application ............................................................................................................... 116 

 Scanning an Image Using Windows XP ................................................................................................................ 117 

 Scanning an Image Using Widows Vista or Windows 7 ................................................................................. 118 

You can import images directly from the scanner into a folder on your computer. With a Macintosh 
computer, and some Windows applications, you can import the images directly into an application. 

 

Scanning an Image into an Application 
 

Notes: 

 To use this feature, the printer must be connected to the computer with a USB cable. 

 Some Windows applications, including Office 2007, do not support this feature. 
 

To import images into an application: 

1. Open the file in which you want to place the image. 

2. In the application, select the menu item to acquire the image. 

3. From the Paper Source menu in Windows, or from the Scan From menu on a Macintosh computer, 
select: 

 Document Glass 

 Document Feeder 

4. Specify the other scan driver settings as desired. 
 

Note: For more information, click the Help button to view the online help. 
 

5. To begin the scan, press the Start button. 

The printer scans the document and places the image in your application. 
 



Scanning 

 

 WorkCentre 6015 Color Multifunction Printer 117 
 User Guide 
 

Scanning an Image Using Windows XP 
 

Note: To use this feature, the printer must be connected to the computer with a USB cable. 
 

1. On your computer, select Start > Control Panel. 

2. Double-click Scanners and Cameras. 

3. Double-click Xerox WC6015. 

4. Select an option: 

 Color picture 

 Grayscale picture 

 Black and white picture or text 

 Custom 

5. Select the paper source: 

 Document Glass 

 Document Feeder 

6. To preview the document or select a portion of the document to scan, select Preview. 

The printer scans a preview copy of the image. 

7. To select a portion of the document to scan, use the corner points to resize the frame. 

8. Click Next. 

9. Type a name for this group of pictures. 

10. Select a file format: 

 BMP 

 TIF 

 JPG 

 PNG 

11. Type in a path name or browse to a location for the scanned images. 

12. To save the image to the folder, select Nothing. 

13. Click Next. 

14. To view the scanned image, click the folder link in the window. 

15. Click Finish. 

The image is stored in the folder and ready for use in your applications. 
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Scanning an Image Using Widows Vista or Windows 7 
 

Note: To use this feature, the printer must be connected to the computer with a USB cable. 
 

1. On your computer, select Start > All Programs > Windows Fax and Scan. 

2. Click New Scan. 

3. If the WorkCentre 6015 Color Multifunction Printer is not already selected, click Change, then 
double-click Xerox WC6015. 

4. Select an option: 

 Add Profile 

 Documents 

 Last used profile 

 Photo (Default) 

5. Select the paper source: 

 Document Glass 

 Document Feeder 

6. Select Color format. 

7. Select a file format: 

 BMP 

 TIF 

 JPG 

 PNG 

8. Select a resolution for the scanned image. 

9. Use the sliders to adjust Brightness and Contrast. 

10. To preview the document or select a portion of the document to scan, select Preview. 

The printer scans a preview copy of the image. 

11. To select a portion of the document, clear the Preview or scan images as separate files check box, 
then use the corner points to resize the frame. 

12. Click Scan. 

The scanned image is stored in the default Scanned Documents folder or in a folder that you 
selected. 
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Adjusting Scanning Settings 

This section includes: 

 Setting the File Format ................................................................................................................................................ 119 

 Setting the Color Mode ................................................................................................................................................ 119 

 Setting the Scan Resolution ....................................................................................................................................... 119 

 Specifying the Original Size........................................................................................................................................ 120 

 Making the Image Lighter or Darker ...................................................................................................................... 120 

 Adjusting the Sharpness .............................................................................................................................................. 120 

 Changing the Auto Exposure Level ......................................................................................................................... 120 

 Setting the Margins ....................................................................................................................................................... 121 

You can modify the scan settings for individual jobs, once you select the scan mode. 

You can also change the default values of some settings. For details, see Changing the Default Scan 
Settings on page 122. 

 

 

Setting the File Format 

1. To select File Format, press the arrow buttons, then press OK. 

2. Select a setting. 

3. Press OK. 
 

Setting the Color Mode 

If the original image contains color, you can scan the image in color or in black and white. Selecting black 
and white significantly reduces the file size of the scanned images. 

To set the color mode: 

1. To select Color Mode, press the arrow buttons, then press OK. 

2. Select a color mode. 

3. Press OK. 
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Setting the Scan Resolution 

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both the 
size and image quality of the scanned image file. Higher scan resolution produces better image quality 
and a larger file size. 

To set the scan resolution: 

1. To select Resolution, press the arrow buttons, then press OK. 

2. Select an option. 

3. Press OK. 
 

Specifying the Original Size 

1. To select Document Size, press the arrow buttons, then press OK. 

2. Select the document size. 

3. Press OK. 
 

Making the Image Lighter or Darker 

1. To select Lighten/Darken, press the arrow buttons, then press OK. 

2. To lighten or darken the image, press the arrow buttons to move the slider. 

3. Press OK. 
 

Adjusting the Sharpness 

1. To select Sharpness, press the arrow buttons, then press OK. 

2. Select a sharpness setting: 

 Sharpest 

 Sharper 

 Normal 

 Softer 

 Softest 

The default setting is Normal. 

3. Press OK. 
 

Changing the Auto Exposure Level 

1. To select Auto Exposure Level, press the arrow buttons, then press OK. 

2. Select an auto exposure setting: 

 Off 

 On 

The default setting is On. 

3. Press OK. 
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Setting the Margins 

1. To select the margin you want to change, press the arrow buttons for: 

 Margin Top/Bottom 

 Margin Left/Right 

 Margin Middle 

2. Press OK. 

3. Adjust the margins from 0.0–2.0 in. using the arrow buttons. 

4. Press OK. 

5. Repeat the steps for other margins, then press the Return button. 
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Changing the Default Scan Settings 

This section includes: 

 Setting the Scan to Network Option ....................................................................................................................... 122 

 Setting the File Format ................................................................................................................................................ 123 

 Changing the Color Mode ........................................................................................................................................... 123 

 Setting the Scan Resolution ....................................................................................................................................... 123 

 Setting the Color Button Sets .................................................................................................................................... 123 

 Specifying the Original Size........................................................................................................................................ 123 

 Making the Image Lighter or Darker ...................................................................................................................... 124 

 Adjusting the Sharpness .............................................................................................................................................. 124 

 Changing the Auto Exposure Level ......................................................................................................................... 124 

 Setting the Margins ....................................................................................................................................................... 124 

 Setting the TIFF File Format ...................................................................................................................................... 125 

 Setting the Image Compression .............................................................................................................................. 125 

 Setting the Maximum Email Size ............................................................................................................................. 125 

The printer uses the default scan settings on all scan jobs unless you change them for an individual job. 
You can modify the default scan settings. 

To change the default scan settings: 

1. On the printer control panel, press the System button. 

2. To select Default Settings, press the arrow buttons, then press OK. 

3. Select Scan Defaults, then press OK. 

4. To select the option that you want to modify, press the arrow buttons, then press OK. 

5. To select the new setting, press the arrow buttons, then press OK. 

Press Return at any time to return to the previous selection. 

 

 

Setting the Scan to Network Option 

1. To select Scan to Network, press the arrow buttons, then press OK. 

2. To select a setting, press the arrow buttons: 

 Computer (Network) 

 Server (FTP) 

3. Press OK. 
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Setting the File Format 

1. To select File Format, press the arrow buttons, then press OK. 

2. Select a setting. 

3. Press OK. 
 

Changing the Color Mode 

1. To select Color, press the arrow buttons, then press OK. 

2. Select a color setting: 

 Black & White 

 Color 

3. Press OK. 
 

Setting the Scan Resolution 

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both the 
size and image quality of the scanned image file. Higher scan resolution produces better image quality 
and a larger file size. 

To set the scan resolution: 

1. To select Resolution, press the arrow buttons, then press OK. 

2. Select an option. 

3. Press OK. 
 

Setting the Color Button Sets 

1. To select Color Button Set, press the arrow buttons, then press OK. 

2. Select B & W Button, then press OK. 

3. Select a setting: 

 Black & White 

 Grayscale 

4. Press OK. 

5. Select Color Button, then press OK. 

6. Select a setting: 

 Color 

 Color (Photo) 

7. Press OK. 
 

Specifying the Original Size 

1. To select Document Size, press the arrow buttons, then press OK. 

2. Select the document size. 

3. Press OK. 
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Making the Image Lighter or Darker 

1. To select Lighten/Darken, press the arrow buttons, then press OK. 

2. To lighten or darken the image, press the arrow buttons to move the slider. 

3. Press OK. 
 

Adjusting the Sharpness 

1. To select Sharpness, press the arrow buttons, then press OK. 

2. Select a sharpness setting: 

 Sharpest 

 Sharper 

 Normal 

 Softer 

 Softest 

The default setting is Normal. 

3. Press OK. 
 

Changing the Auto Exposure Level 

1. To select Auto Exposure Level, press the arrow buttons, then press OK. 

2. Select an auto exposure setting: 

 Off 

 On 

The default setting is On. 

3. Press OK. 
 

Setting the Margins 

1. To select the margin you want to change, press the arrow buttons for: 

 Margin Top/Bottom 

 Margin Left/Right 

 Margin Middle 

2. Press OK. 

3. Adjust the margins from 0.0–2.0 in. using the arrow buttons. 

4. Press OK. 

5. Repeat the steps for other margins, then press the Return button. 
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Setting the TIFF File Format 
 

Note: TIFF files created by this printer can fail to open properly in some computer applications. 
 

1. To select TIFF File Format, press the arrow buttons, then press OK. 

2. Select a setting: 

 TIFF V6 

 TTN2 

3. Press OK. 
 

Setting the Image Compression 

1. To select Image Compression, press the arrow buttons, then press OK. 

2. Select a setting: 

 Higher 

 Normal 

 Lower 

3. Press OK. 
 

Setting the Maximum Email Size 

1. To select Max Email Size, press the arrow buttons, then press OK. 

2. To set a size from 50–16384 KB, press the arrow buttons, or use the alphanumeric keypad. 

The default setting is 2048 KB. 

3. Press OK. 
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Limiting Access to Scanning 

The Scan Lock options limit access to scanning by requiring a password to use the Scan function. You can 
also turn off scanning. 

To set the Scan Lock: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. If prompted, enter the four-digit password, then press OK. 

4. Select Secure Settings, then press OK. 
 

Note: Panel Lock must be enabled before setting the service locks. For more information, see 
Changing the Panel Lock Password on page 142. 

 

5. Select Service Lock, then press OK. 

6. Select an option: 

 Scan to Computer 

 PC Scan 

 Scan to Email 

 Scan to Network 

 Scan to USB Memory 

7. Press OK. 

8. Select an option: 

 Unlocked turns off the service lock. 

 Locked turns on the service lock, and turns off the scan function. 

 Password Locked requires a password to use the scan function. Enter a new password, then 
press OK. 

9. Press OK. 
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This chapter includes: 

 Loading Documents for Faxing ................................................................................................................................ 128 

 Basic Faxing ..................................................................................................................................................................... 129 

 Using the Fax Book........................................................................................................................................................ 131 

 Selecting Fax Options for Single Jobs .................................................................................................................... 137 

 Configuring the Printer for Faxing ........................................................................................................................... 139 

 Managing Fax Functions ............................................................................................................................................. 140 
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Loading Documents for Faxing 

Position the original document as shown. 
 

 
 

Document Glass 

Lift the automatic document feeder or 
the document glass cover, then place the 
original face down in the upper left corner 
of the document glass. 

Automatic Document Feeder 

Insert originals face up with the top of the page 
entering the feeder first. Adjust the paper guides so 
they fit against the originals. 

 

Note: For details, see Automatic Document Feeder Guidelines on page 95. 
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Basic Faxing 

This section includes: 

 Sending a Fax From the Printer ................................................................................................................................ 129 

 Sending a Fax From Your Computer ....................................................................................................................... 130 
 

Note: Before faxing, you must set the country code and fax number for the printer. For details, see 
Setting Up the Fax Header on page 56. 

 

Sending a Fax From the Printer 

To send a fax from the printer to a single recipient using the default settings: 

1. Load the original on the document glass or in the automatic document feeder. 

2. On the printer control panel, press the Fax button. 

3. At Fax to, press the OK button. 

4. To address the fax, press the arrow buttons to select an option: 

 Keypad allows you to enter the fax number manually using the alphanumeric keypad. 

 Speed Dial allows you to select a previously programmed speed dial. Use the alphanumeric 
keypad to enter a three-digit speed dial number. 

 Fax Book allows you to select a number from the Fax Address Book. For details, see Faxing to an 
Individual in the Address Book on page 133. 

 Group Dial allows you to send the fax to numerous recipients. For details, see Faxing to an 
Address Book Group on page 136. 

5. Press OK. 

6. To select the fax options you want to change, press the arrow buttons, then press OK. For details, see 
Selecting Fax Options for Single Jobs on page 137. 

7. Press the green Start button. 

8. If the Another Page? prompt appears, select an option: 

 No completes the scanning process. 

 Yes prompts you to place the next page on the document glass. 

9. Select Continue or Cancel the Action. 

10. Press OK. 

11. The printer scans the pages and transmits the fax. 

 
 

Note: If monitor reports are set to print, the report shows the fax transmission status. For details, see 
Printing Monitor Reports on page 140. 

  

See also:  
Using the Fax Address Book on page 131 
Managing Fax Functions on page 140 
Printing Monitor Reports on page 140 
Inserting Pauses in Fax Numbers on page 143 
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Sending a Fax From Your Computer 

This section includes: 

 Sending a Fax Using Windows Applications ........................................................................................................ 130 

 Sending a Fax Using Macintosh Applications ..................................................................................................... 130 

You can send a fax to the printer from an application on your computer. 

 

 

Sending a Fax Using Windows Applications 

You can send a fax from many Windows applications by using the fax driver. 

To send a fax from a Windows XP SP1 and later, or Windows Server 2003 and later computer: 

1. In the application, access the Print dialog box. 

2. To select your WorkCentre 6015-xxxx Fax printer, click the printer name once, then click Properties 
or Preferences to open the Fax Properties or Printing Preferences window. 

3. Select the options for the following: 

 Quality 

 Paper Size 

 Image Orientation 

4. Click OK. 

5. To open the Recipient Setting window, do one of the following: 

 For Windows Vista and Windows 7, click OK. 

 For earlier versions of Windows, click Print. 

6. Add recipients to the Recipient List. For more information, click the Help button to view the online 
help. 

7. To delay sending the fax, select the Delayed Send check box, then adjust the delay time. 

8. Click Start Sending to send the fax. 

To stop a fax from sending, click the Stop Sending button. 
 

Sending a Fax Using Macintosh Applications 

To send a fax from a Macintosh OS X version 10.5 and later computer, download the latest driver from 
www.xerox.com/office/WC6015drivers. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=driver&Language=English
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Using the Fax Book 

This section includes: 

 Faxing to an Individual ................................................................................................................................................ 132 

 Faxing to a Group .......................................................................................................................................................... 134 

You can create and save fax information for individuals or groups. You can select saved names and 
numbers without re-entering them each time you want to send a fax. 
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Faxing to an Individual 

This section includes: 

 Adding an Individual Fax Address Book Entry .................................................................................................... 132 

 Faxing to an Individual in the Address Book ....................................................................................................... 133 

You can set up and save individual names and fax numbers to use when you want to send a fax. 

 

 

Adding an Individual Fax Address Book Entry 

You can create individual address book entries using CentreWare Internet Services or the Address Book 
Editor. Use the book entries when sending faxes from the printer or from your computer. 

To add an individual entry using CentreWare Internet Services: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. In CentreWare Internet Services, click Address Book. 

3. Under Address Book in the left navigation pane, click FAX Address Book. 

4. In the Directory Listing, click the Add button for an entry that is not in use. 
 

Note: The first eight entries in the Address Book correspond to the eight one-touch buttons on the 
left side of the printer control panel. 

 

5. Type the name, phone number, and email address for the individual. 

6. Click the Save Changes button to create the address. 

The address book is saved in the printer with the entries. 
 

Note: Three-digit speed dial entries are assigned automatically in CentreWare Internet Services. 

To add an individual entry using the Address Book Editor: 

1. To access the Address Book Editor, do one of the following: 

 For Windows computers, select Start > Programs > Xerox > WorkCentre 6015 > Address Book 
Editor. 

 For Macintosh computers, open the Applications folder, select Xerox > WorkCentre 6015 > 
Address Book Editor, then click OK. 

2. If an Address Book Editor Select Device window opens, click the link for the WorkCentre 6015 Fax. 

3. In the left pane, right-click the Fax/Email icon, then select New > New Entry. 

The Personal Address dialog box appears. The Address Book Editor automatically assigns the speed 
dial number to the first empty entry. 
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4. To assign the speed dial number manually, select the Specify an Address Number check box, then 
enter a value from 1–200. 

 

Note: The first eight entries in the Address Book correspond to the eight one-touch buttons on the 
left side of the printer control panel. 

 

5. Type the name, phone number, and email address for the individual. To insert a pause, type a 
hyphen. 

6. To add this entry to an existing group: 

a. Click Group Membership. 

b. Select the groups to add this entry to, then click Add. 

c. Confirm the group members, then click OK. 

7. Click OK. 

8. Click the File menu, then select Save All. 

The address book is saved in the printer with the entries. 
 

Faxing to an Individual in the Address Book 

1. On the printer control panel, press the Fax button. 

2. At Fax to, press the Address Book button. 

3. At All Entries, press the OK button. 

4. To scroll through the address book list, press the arrow buttons, then press OK to select the recipient. 
You can select more than one recipient. 

5. After selecting the recipients, press OK. 

6. Press the green Start button. 

To stop a fax from sending, click the Stop Sending button. 
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Faxing to a Group 

This section includes: 

 Creating a Fax Group ................................................................................................................................................... 134 

 Editing Address Book Fax Groups ............................................................................................................................ 135 

 Faxing to an Address Book Group ........................................................................................................................... 136 

 Searching the Local Phone Book .............................................................................................................................. 136 

To send a fax to multiple individuals, create a group speed dial entry. Groups can include both previously 
stored individual and group entries. 
 

Note: Individual entries must be set up before groups can be defined. For details, see Adding an 
Individual Fax Address Book Entry on page 132. 

 

 

 

Creating a Fax Group 

You can create group address book entries using CentreWare Internet Services or the Address Book 
Editor. 

To create a fax group using CentreWare Internet Services: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. In CentreWare Internet Services, click Address Book. 

3. Under Address Book in the left navigation pane, click FAX Groups. 

4. In Directory Listing, click the Add link of any group that is not in use. 

5. Type a group name, then click the Save Changes button. 

6. When you see a Request Acknowledged message, click the Return button. 

7. Click the Edit link for the group you created. 

8. Select the check boxes of individuals you want to include in the group. 

9. Click the Additional Entries links at the bottom of the Group Members column to see additional Fax 
Address Book entries. You can also add existing groups to this group. 

10. When you have finished selecting group members, click Save Changes. 

The address book is saved in the printer with the entries. 
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To create a fax group using the Address Book Editor: 

1. To access the Address Book Editor, do one of the following: 

 For Windows computers, select Start > Programs > Xerox > WorkCentre 6015 > Address Book 
Editor. 

 For Macintosh computers, open the Applications folder, select Xerox > WorkCentre 6015 > 
Address Book Editor, then click OK. 

2. In the left pane, right-click the Fax/Email icon, then select New > New Group. 

The Group Dial dialog box opens. The Address Book Editor automatically assigns the Group ID to the 
first empty entry. 

3. To specify the Group ID manually, select the Specify an Address Number check box, then enter a 
value from 1–6. 

4. Type a group name in the Group Name field. 

5. Click the Add or Delete button. 

6. Select group members from the list on the left side of the screen, then click the Add button to add 
them to the group. To select multiple group members, press and hold the Ctrl key while making 
selections. 

7. When you have finished adding group members, click OK. 

8. Click OK a second time to create the group. 

9. Confirm the group members, then click OK to save the group. 

10. Click the File menu, then select Save All. 

The address book is saved in the printer with the entries. 
 

Editing Address Book Fax Groups 

You can edit address book entries using CentreWare Internet Services, or use the Address Book Editor to 
add or delete individuals from the groups. 

To edit an existing fax group using CentreWare Internet Services: 

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 
press Enter or Return. 

 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 55. 

 

2. In CentreWare Internet Services, click Address Book. 

3. Under Address Book in the left navigation pane, click FAX Groups. 

4. In the Directory Listing, click Edit to the right of the group you want to edit. 

5. Click the Add or Delete button. 

6. Select the check boxes of the individuals that you want in the group. 

7. Clear the check boxes of the individuals that you want to remove from the group. 

8. To see additional Fax Address Book entries, click the Additional Entries links at the bottom of the 
Group Members column. 

9. When you have finished editing the group, click Save Changes. 

The address book is saved in the printer with the entries. 
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To edit an existing fax group using the Address Book Editor: 

1. To access the Address Book Editor, do one of the following: 

 For Windows computers, select Start > Programs > Xerox > WorkCentre 6015 > Address Book 
Editor. 

 For Macintosh computers, open the Applications folder, select Xerox > WorkCentre 6015 > 
Address Book Editor, then click OK. 

2. In the left pane, click the Fax icon. 

3. In the upper right pane, right-click the group you want to edit, then select Edit. 

4. Click the Group Membership button. 

5. To add individuals, select entries from the list on the left side of the screen, then click Add. 

6. To remove individuals, select entries from the list on the right side of the screen, then click Delete. 

7. Click OK. 

8. Confirm the group members, then click OK. 

9. Click the File menu, then select Save all. 

The address book is saved in the printer with the entries. 
 

Faxing to an Address Book Group 

1. On the printer control panel, press the Fax button. 

2. At Fax to, press the Address Book button. 

3. To select Group Dial, press the arrow buttons, then press OK. 

4. To select the group, press the arrow buttons to scroll through the address book list, then press OK. 
You can select more than one group. 

5. After selecting the groups, press OK. 

6. Press the green Start button. 
 

Searching the Local Phone Book 

You can search for an individual or group in the local Fax Book by using a partial name. 

To search the Fax Book for an individual or group: 

1. On the printer control panel, press the Fax button. 

2. At Fax to, press the OK button. 

3. To select Search Fax Book, press the arrow buttons, then press OK. 

4. Use the alphanumeric keypad to enter the search text, then press OK. The search is case-sensitive. 

5. To scroll through the local address book results, press the arrow buttons. 

6. To select the entry, press OK. 

7. Press OK. 
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Selecting Fax Options for Single Jobs 

This section includes: 

 Setting the Fax Resolution ......................................................................................................................................... 137 

 Making the Image Lighter or Darker ...................................................................................................................... 137 

 Turning OnHook On or Off ......................................................................................................................................... 137 

 Sending a Delayed Fax ................................................................................................................................................ 137 

 Including a Fax Cover Page ....................................................................................................................................... 138 

 Setting Up Polling .......................................................................................................................................................... 138 
 

 

Setting the Fax Resolution 

1. On the printer control panel, press the Fax button. 

2. To select Resolution, press the arrow buttons, then press OK. 

3. Select an option. The default setting is Standard. 

4. Press OK. 
 

Making the Image Lighter or Darker 

1. On the printer control panel, press the Fax button. 

2. To select Lighten/Darken, press the arrow buttons, then press OK. 

3. To move the slider to lighten or darken the fax, press the arrow buttons. The default setting is 
Normal. 

4. Press OK. 
 

Turning OnHook On or Off 

When you turn on the OnHook option, the telephone line is ready to dial out when you enter a phone 
number. You cannot receive incoming faxes while OnHook is turned on. 

To turn OnHook on or off: 

1. On the printer control panel, press the Fax button. 

2. To select OnHook, press the arrow buttons, then press OK. 

3. Select Off or On, then press OK. 
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Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. The time delay can be from 15 
minutes to 24 hours from the current time. 
 

Note: The printer must be set to the current time before you can use this feature. 
 

To send a fax at a specified time: 

1. On the printer control panel, press the Fax button. 

2. To select Delayed Start, press the arrow buttons, then press OK. 

3. Select On, then press OK. 

4. Select the time to send the fax: 

a. To select a number from 0–23 for the hour, press the arrow buttons. 

b. To select Minutes, press the Forward or Back Arrow buttons. 

c. To select a number from 0–59 for minutes, press the Up or Down Arrow buttons, then press OK. 

5. Press the green Start button. 

The fax is scanned and saved, and sent at the time you specified. 
 

Including a Fax Cover Page 

1. On the printer control panel, press the Fax button. 

2. To select Fax Cover Page, press the arrow buttons, then press OK. 

3. Select On, then press OK. 
 

Setting Up Polling 

Fax Polling allows you to store a fax document on the printer and make it available for other fax 
machines to poll. You can also retrieve faxes stored on other fax machines. 
 

Note: Both printers must have the Fax Polling feature. 
 

To turn on Polling: 

1. On the printer control panel, press the Fax button. 

2. To select Polling, press the arrow buttons, then press OK. 

3. Select On, then press OK. 
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Configuring the Printer for Faxing 

Before you use the fax, you must configure the Fax Settings to make it compatible with your local 
connection and regulations. The Fax Settings include optional features you can use to configure the 
printer for faxing. 

To configure the printer for faxing: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

If prompted, enter the password, then press OK. 

3. Select Fax Settings, then press OK. 

4. Change the fax settings as desired. 

5. Press OK. 

For details on the Fax Settings menu items, see Fax Settings on page 30. 
 

Changing the Default Fax Settings 

1. On the printer control panel, press the System button. 

2. To select Default Settings, press the arrow buttons, then press OK. 

3. Select Fax Defaults, then press OK. 

4. To select the option that you want to modify, press the arrow buttons, then press OK. 

5. To select the new setting, press the arrow buttons, then press OK. 

For details on Fax Default menu items, see Fax Defaults on page 36. 

 



Faxing 

 

140 WorkCentre 6015 Color Multifunction Printer 
 User Guide 
 

Managing Fax Functions 

This section includes: 

 Printing Monitor Reports ............................................................................................................................................. 140 

 Printing a Monitor Report for a Group Fax ........................................................................................................... 140 

 Turning Secure Fax Receive On or Off ................................................................................................................... 141 

 Limiting Access to Faxing ........................................................................................................................................... 141 

 Printing Fax Reports ...................................................................................................................................................... 142 

 Inserting Pauses in Fax Numbers ............................................................................................................................. 143 
 

 

Printing Monitor Reports 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. If prompted, enter the password, then press OK. 

4. Select Fax Settings, then press OK. 

5. To select Fax Transmit, press the arrow buttons, then press OK. 

6. Select an option: 

 Print Always prints a monitor report for every fax. This is the default setting. 

 Print on Error prints a monitor report when an error occurs with the fax transmission. 

 Print Disabled does not print a monitor report. 

7. Press OK. 
 

Printing a Monitor Report for a Group Fax 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. If prompted, enter the password, then press OK. 

4. Select Fax Settings, then press OK. 

5. Select Fax Broadcast, then press OK. 

6. Select an option: 

 Print Always prints a monitor report for every fax. This is the default setting. 

 Print on Error prints a monitor report when an error occurs with the fax transmission. 

 Print Disabled does not print a monitor report. 

7. Press OK. 
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Turning Secure Fax Receive On or Off 

When the Secure Receive setting is enabled, you must enter a password before faxes can be printed. 

To turn Secure Receive Lock on or off: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. If prompted, enter the password, then press OK. 

4. Select Secure Settings, then press OK. 

5. Select Secure Receive, then press OK. 

6. At Secure Receive Set, press OK. 

7. Select Enable or Disable, then press OK. 

8. To change your password: 

a. Select Change Password, then press OK. 

b. Enter the current password, then press OK. 

c. Enter a new four-digit password, then press OK. The default password is 0000. 

 
 

Printing Secure Faxes 

When the Secure Receive setting is enabled, you must enter a password before faxes can be printed. 

To print all secure faxes: 

1. On the printer control panel, press the Fax button. 

2. At Secure Receive, press OK. 

When prompted, enter your four-digit password, then press OK. 
 

Limiting Access to Faxing 

The Fax Lock options limit access to faxing by requiring a password to use the Fax function. You can also 
turn off faxing. 

To set the Fax Lock: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. If prompted, enter the password, then press OK. 

4. Select Secure Settings, then press OK. 

5. Select Service Lock, then press OK. 

6. Select Fax, then press OK. 
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7. Select an option: 

 Unlocked turns off the service lock. 

 Locked turns on the service lock, and turns off the fax function. 

 Password Locked requires a password to use the fax function. Enter a new password, then press 
OK. 

8. Press OK. 
 

Changing the Panel Lock Password 

The Panel Lock password limits access to the Admin menu. 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Enter the current four-digit password, then press OK. 

4. Select Secure Settings, then press OK. 

5. At Panel Lock, press OK. 

6. Select Change Password, then press OK. 

7. Enter a new four-digit password, then press OK. The default password is 0000. 
 

Limiting Who Can Send Faxes to the Printer 

When the Junk Fax Filter setting is On, the printer only receives faxes from phone numbers in the address 
book. 

To turn the Junk Fax Filter on or off: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. If prompted, enter the password, then press OK. 

4. Select Fax Settings, then press OK. 

5. Select Junk Fax Filter, then press OK. 

6. Select an option: 

 Off allows anyone to send you a fax. 

 On only receives faxes from phone numbers in the printer address book. 

7. Press OK. 
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Printing Fax Reports 

Fax reports provide information about faxing activities, directories, and pending jobs. 

To print a fax report: 

1. On the printer control panel, press the System button. 

2. At Information Pages, press OK. 

3. If prompted, enter the password, then press OK. 

4. To select Fax Activity, press the arrow buttons, then press OK. 

5. Press OK to print the report. 
 

Inserting Pauses in Fax Numbers 

Some fax numbers require one or more pauses during the dialing sequence. 

To insert pauses in a fax number: 

1. On the printer control panel, press the Fax button. 

2. Select Fax To, then press OK. 

3. To select Keypad, press the arrow buttons, then press OK. 

4. Use the alphanumeric keypad to enter the fax number. 

If necessary, press the Redial/Pause button to insert a pause, represented by a hyphen. Press the 
Redial/Pause button multiple times to add additional pauses. 

5. Press the green Start button. 
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Cleaning the Printer 

This section includes: 

 General Precautions ...................................................................................................................................................... 146 

 Cleaning the Scanner ................................................................................................................................................... 147 

 Cleaning the Exterior .................................................................................................................................................... 149 

 Cleaning the Interior .................................................................................................................................................... 149 
 

 

General Precautions 
 

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed 
in this documentation. 

 
 

 WARNING: Keep all cleaning materials out of the reach of children. 
 
 

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners 
increase the risk of fire and explosion. 

 
 

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

 Do not place anything on top of the printer. 

 Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 
exposure can damage the imaging units. 

 Do not open covers and doors during printing. 

 Do not tilt the printer while it is in use. 

 Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 
quality to deteriorate. 

 Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Scanner 

1. Slightly dampen a soft, lint-free cloth with water. 

2. Lift and open the scanner. 

 
3. Remove any paper or other media from the output tray. 

 
4. Wipe the area under the scanner until it is clean. 

5. Lower the scanner and close it. 
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6. Open the document cover. 

 
7. Wipe the surface of the document glass until it is clean and dry. 
 

Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks. 
 

 
8. Wipe the white underside of the document cover until it is clean and dry. 
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9. Close the document cover. 

 
 

Cleaning the Exterior 

Clean the exterior of the printer once a month. 

 Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 

 After cleaning, wipe with a dry, soft cloth. 

 For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain 
off. 

 

 CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer 
through a gap and cause problems. Never use cleaning agents other than water or mild detergent. 

 
 

Cleaning the Interior 

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing 
the printer covers. 

 Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 173. 

 Remove any dust or stains with a dry, clean cloth. 
 
 

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a 
sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the 
printer immediately and wait 20 minutes for the fuser to cool. Try to remove the jam after the printer 
has cooled. 

 
 



Maintenance 

 

150 WorkCentre 6015 Color Multifunction Printer 
 User Guide 
 

Cleaning Inside the Printer 

1. Turn off the printer. 

2. Open the side door. 

 
3. Pinch the release tab on the toner cartridge as shown. 

 
4. Pull out the toner cartridge. 
 

Note: To avoid spilling toner, pull out the toner cartridge slowly. 
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5. Remove the remaining toner cartridges in the same manner. 

6. Pull out the cleaning rod. 
 

Note: To remove toner and debris from the top of the cleaning rod, wipe it with a clean lint-free cloth. 
 

 
7. Insert the cleaning rod into the hole indicated by the arrow in the middle of the toner cartridge slot. 

Push in the cleaning rod until it stops, then pull it out. 

 
8. Repeat the procedure for the holes in the other three slots. 

9. Return the cleaning rod to its original location. 

 



Maintenance 

 

152 WorkCentre 6015 Color Multifunction Printer 
 User Guide 
 

10. Align the black toner cartridge with the rear toner slot. Press firmly near the center of the cartridge 
until it clicks into place. 

 
11. Replace the remaining three toner cartridges in the same manner. 

12. Close the side door. 
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Cleaning the LED Lenses 

If prints have voids or light streaks through one or more color, use the following instructions to clean the 
Light Emitting Diode (LED) lenses. 
 

 WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If 
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on 
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water and consult a doctor. 

 

1. Turn off the printer. 

2. Open the side door. 

 
3. Pinch the release tab on the toner cartridge as shown. 

 
4. Pull out the toner cartridge. 
 

Note: To avoid spilling toner, pull out the toner cartridge slowly. 
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5. Remove the remaining toner cartridges in the same manner. 

6. Pull out the cleaning rod. 
 

Note: To remove toner and debris from the top of the cleaning rod, wipe it with a clean lint-free cloth. 
 

 
7. Insert the cleaning rod into the hole indicated by the arrow in the middle of the toner cartridge slot. 

Push in the cleaning rod until it stops, then pull it out. 

 
8. Repeat the procedure for the holes in the other three slots. 

9. Return the cleaning rod to its original location. 
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10. Align the black toner cartridge with the rear toner slot. Press firmly near the center of the cartridge 
until it clicks into place. 

 
11. Replace the remaining three toner cartridges in the same manner. 

12. Close the side door. 

 
 

Cleaning the Color Toner Density Sensors 
 

Note: Clean the color toner density (CTD) sensors when an alert for the CTD sensors appears on the 
control panel or in PrintingScout Printer Status window. 

 

1. Turn off the printer. 

2. Push down the rear cover release lever and pull open the cover. 
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3. Use a dry cotton swab to clean the color toner density sensors. 

 
4. Close the rear cover. 
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Adjustments and Maintenance Procedures 

This section includes: 

 Color Registration .......................................................................................................................................................... 157 

 Adjusting Paper Type ................................................................................................................................................... 158 

 Adjusting the Bias Transfer Roller ........................................................................................................................... 158 

 Adjusting the Fuser ....................................................................................................................................................... 158 

 Refreshing the Bias Transfer Roller ......................................................................................................................... 159 

 Adjusting the Altitude .................................................................................................................................................. 159 
 

 

Color Registration 

The printer automatically adjusts the color registration when automatic adjustment is turned on. You can 
also adjust color registration manually any time the printer is idle. You must adjust the color registration 
any time the printer is moved. If you are having printing problems, adjust the color registration. 
 

Setting Automatic Color Registration 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Auto Regi Adjust, then press OK. 

5. Select On, then press OK. 

6. To return to the Ready screen, press Return. 
 

Performing an Automatic Color Registration Adjustment 

Automatic color registration adjustment occurs every time a new toner cartridge is installed. You can run 
this adjustment at other times as needed. 

To perform an automatic color registration adjustment: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Adjust Color Regi, then press OK. 

5. At Auto Adjust, press OK. 

6. At the Are you sure? prompt, press the arrow buttons to select Yes. 

7. To begin the calibration, press OK. 
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Adjusting Paper Type 

Use Adjust Paper Type to compensate for paper thickness within a paper type. If the printed image is too 
light, use a heavier setting for the paper you are using. If the printed image is mottled or blotchy-looking, 
decrease the setting for the paper you are using. 

To adjust the paper type: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Adjust Paper Type, then press OK. 

5. Select Plain or Label, then press OK. 

6. Select Lightweight or Heavyweight, then press OK. 

7. To return to the Ready screen, press Return. 
 

Adjusting the Bias Transfer Roller 

Use Adjust BTR to specify the bias transfer roller (BTR) voltage for printing on the selected paper type. If 
the printed image is too light, increase the offset for the paper you are using. If the printed image is 
mottled or blotchy-looking, decrease the offset for the paper you are using. 

To adjust the bias transfer roller: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Adjust BTR, then press OK. 

5. Press the arrow buttons to select the paper type for the adjustment, then press OK. 

6. Press the arrow buttons to increase or decrease the amount of offset, then press OK. 

7. Repeat this procedure for each paper type you need to adjust. 

8. To return to the Ready screen, press Return. 
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Adjusting the Fuser 

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is 
smearing or can be rubbed off the paper, increase the offset for the paper you are using. If the toner is 
blistered or mottled, decrease the offset for the paper you are using. 

To adjust the fuser: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Adjust Fuser, then press OK. 

5. Press the arrow buttons to select the paper type for the adjustment, then press OK. 

6. Press the arrow buttons to increase or decrease the amount of offset, then press OK. 

7. Repeat this procedure for each paper type you need to adjust. 

8. To return to the Ready screen, press Return. 
 

Refreshing the Bias Transfer Roller 

Use the BTR Refresh procedure to reduce paper curling and improve paper discharge. 

To refresh the bias transfer roller: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select BTR Refresh, then press OK. 

5. Select On, then press OK. 

6. To return to the Ready screen, press Return. 
 

Adjusting the Altitude 

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If 
the altitude setting is incorrect, it can cause print-quality problems. 

To adjust the altitude: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Adjust Altitude, then press OK. 

5. Press the arrow buttons to select the altitude of the location of the printer, then press OK. 

6. To return to the Ready screen, press Return. 
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Ordering Supplies 

This section includes: 

 Consumables ................................................................................................................................................................... 160 

 When to Order Supplies ............................................................................................................................................... 160 

 Toner Cartridges ............................................................................................................................................................. 161 

 Recycling Supplies .......................................................................................................................................................... 162 
 

 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black. 
 

Notes: 

 Each consumable includes installation instructions. 

 Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner 
remaining amount displayed could be inaccurate. 

 To ensure print quality, the toner cartridge has been designed to cease functioning at a 
predetermined point. 

 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by 
Xerox for specific use with this printer. 

 
 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/WC6015supplies. 
 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 

 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=order&Language=English
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Toner Cartridges 

This section includes: 

 General Precautions ...................................................................................................................................................... 161 

 Replacing a Toner Cartridge ...................................................................................................................................... 161 

 Refreshing the Toner .................................................................................................................................................... 162 

 Cleaning the Developer ............................................................................................................................................... 162 
 

 

General Precautions 
 

 WARNINGS:  

 When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, 
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

 Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, 
have the child spit out the toner, and rinse out their mouth with water. Consult a 
physician immediately. 

 
 

 WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. 
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of 
toner, contact your local Xerox representative. 

  

 WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can 
catch fire and cause burn injuries or an explosion. 

 
 
 

Replacing a Toner Cartridge 

When a toner cartridge reaches its usable life span, the control panel displays a message. PrintingScout 
displays the toner status in the Printer Status window. When a toner cartridge is empty, the printer stops 
and displays messages on the control panel and in the PrintingScout Printer Status window. 

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining 
amount displayed could be inaccurate. 
 

Note: Each toner cartridge includes installation instructions. 
 
 

Printer Status Message Cause and Solution 

Printer Toner Cartridge is Close to Life. The toner cartridge is low. Order a new toner cartridge. 

Replace the toner cartridge or check that the toner 
cartridge is properly seated. 

The toner cartridge is empty. Replace the toner cartridge 
with a new one. 

 
 



Maintenance 

 

162 WorkCentre 6015 Color Multifunction Printer 
 User Guide 
 

Refreshing the Toner 

Use Toner Refresh to use the last of the toner in a cartridge before you replace it, or to stir toner in a new 
cartridge. 

To refresh the toner: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Toner Refresh, then press OK. 

5. To select the toner to refresh, press the arrow buttons, then press OK. 

6. Select Yes, then press OK. 

The process runs automatically. Wait three minutes for the process to complete and the printer to 
return to Ready. 

 

Note: Do not use this procedure repeatedly for a single toner color. Running the procedure repeatedly 
uses the toner supply more quickly. 

 
 

Cleaning the Developer 

Clean Developer runs the developer motor and stirs the toner in the toner cartridge. Use Clean Developer 
to clean toner from a cartridge just before changing it or to refresh the toner after replacing a toner 
cartridge. 

To clean the developers: 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Select Maintenance, then press OK. 

4. Select Clean Developers, then press OK. 

5. Select Yes, then press OK. 

The process runs automatically. Wait three minutes for the process to complete and the printer to 
return to Ready. 

 

Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=recyclesupplies&Language=English%20%20
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Managing the Printer 

This section includes: 

 Checking Page Counts .................................................................................................................................................. 163 

 Changing the Panel Lock Password ......................................................................................................................... 163 
 

 

Checking Page Counts 

You can check the total number of printed pages on the System Settings page. It lists the print volume by 
the total number of pages printed on each paper size. 

Use Billing Meters to view impression count details for the printer. The current counts for color, black and 
white, and combined total impressions appear on the Billing Meters screen. The impression counts shown 
are used for billing. A page is one side of a sheet of paper that can be printed on one or two sides. A sheet 
printed on two sides counts as two impressions. 
 

Printing the System Settings Page 

1. On the printer control panel, press the System button. 

2. At Information Pages, press OK. 

3. Select System Settings using the arrow buttons. 

4. Press OK. 
 

Viewing the Billing Meters 

1. On the printer control panel, press the System button. 

2. Press the arrow buttons to select Billing Meters. 

3. Press OK. 
 

Changing the Panel Lock Password 

The Panel Lock password limits access to the Admin menu. 

1. On the printer control panel, press the System button. 

2. To select Admin Menu, press the arrow buttons, then press OK. 

3. Enter the current four-digit password, then press OK. 

4. Select Secure Settings, then press OK. 

5. At Panel Lock, press OK. 

6. Select Change Password, then press OK. 

7. Enter a new four-digit password, then press OK. The default password is 0000. 
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Moving the Printer 

Follow these instructions when moving the printer: 

1. Turn off the printer and disconnect the power cord and other cables from the back of the printer. 

  
 

 WARNING: To prevent electric shock, never touch the power plug with wet hands. When removing the 
power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can 
lead to fire or electric shock. 

 

2. Remove any paper or other media from the output tray. If the output tray extension is extended, 
close it. 

 
3. Remove the paper from the paper tray. 

Keep the paper wrapped and away from humidity and dirt. 
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4. Lift the bypass tray and push it into the printer. 

 
5. Push in the length guides and slide bar until they stop. 

 
6. Fold up the main tray to cover the paper feed. 

  
7. Lift and carry the printer as shown in the illustration. 
 

Note: To find the weight for your printer configuration, see Physical Specifications on page 191. 
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 CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered by 
the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, 
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by 
improper moving. 

 

When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or right. Tilting the 
printer more than 10 degrees can cause toner spillage. 

After moving the printer: 

1. Reinstall any parts you removed. 

2. Reconnect the printer to the cables and power cord. 

3. Plug in and turn on the printer. 
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This chapter includes: 

 General Troubleshooting............................................................................................................................................. 168 

 Paper Jams ....................................................................................................................................................................... 171 

 Getting Help ..................................................................................................................................................................... 187 
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General Troubleshooting 

This section includes: 

 Printer Does Not Turn On ............................................................................................................................................ 168 

 Printer Resets or Turns Off Frequently ................................................................................................................... 168 

 The Printer Does Not Print .......................................................................................................................................... 169 

 Printer is Making Unusual Noises ............................................................................................................................. 169 

 Condensation has Formed Inside the Printer ...................................................................................................... 170 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 

Printer Does Not Turn On 
 

Probable Causes Solutions 

The power switch is not turned on. Turn on the switch. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer power switch, and plug the power cord securely 
into the outlet. 

Something is wrong with the outlet connected 
to the printer. 

 Plug another electrical appliance into the outlet and see if it 
operates properly. 

 Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 194. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
 
 

Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. 

A system error occurred. Turn off the printer, then turn it on again. Print the Error History from 
the Information Pages of the Printer Setting Utility. If the error 
persists, contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Turn off the printer, then connect the power cord to a suitable outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other high-power devices. 
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The Printer Does Not Print 
 

Probable Causes Solutions 

The printer is in Energy Saver mode. Push the control panel button. 

PrintingScout displays an error message. Follow the instructions in the PrintingScout message to correct the 
problem. If the error persists, contact your Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

The Error Indicator is blinking. If the Ready Indicator is off, the printer has stopped working. Turn 
off the printer, then turn it on again. If the error persists, contact 
your Xerox representative. 

Both control panel indicators are off. Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. If the 
error persists, contact your Xerox representative. 

The printer is busy.  If the Ready Indicator is flashing, it is normal. A previous print job 
could be the problem. Use PrintingScout to delete all print jobs in 
the print queue. 

Load the paper in the tray. 

 If the Ready Indicator is not flashing after you send a print job, 
check the USB connection between the printer and the computer. 
Turn off the printer, then turn it on again. 

The printer cable is disconnected.  If the Ready Indicator is not flashing after you send a print job, 
check the USB connection between the printer and the computer. 

 For the WorkCentre 6015N/NI Color Multifunction Printer: If the 
Ready Indicator is not flashing after you send a print job, check 
the Ethernet connection between the printer and the computer. 

 
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox representative. 
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Condensation has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is located 
in a warm room. Condensation can form in a printer after it has been sitting in a cold room that is heated 
quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. Allow the printer to operate for several hours at room temperature. 

The relative humidity of the room is too high.  Reduce the humidity in the room. 

 Move the printer to a location where the temperature and 
relative humidity are within the operating specifications. 
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Paper Jams 

This section includes: 

 Minimizing Paper Jams ................................................................................................................................................ 171 

 Locating Paper Jams ..................................................................................................................................................... 172 

 Clearing Paper Jams...................................................................................................................................................... 173 

 Troubleshooting Paper Jams ..................................................................................................................................... 179 

 Print-Quality Problems ................................................................................................................................................. 181 
 

 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox® supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 

 Selecting the incorrect paper type in the print driver. 

 Using damaged paper. 

 Using unsupported paper. 

 Loading paper incorrectly. 

 Overfilling the tray. 

 Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 

 Use only supported paper. For details, see Supported Paper on page 72. 

 Follow proper paper handling and loading techniques. 

 Always use clean, undamaged paper. 

 Avoid paper that is curled, torn, moist, creased, or folded. 

 To separate the sheets before loading into the tray, fan the paper. 

 Observe the paper tray fill line; never overfill the tray. 

 Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 
can cause poor print quality, misfeeds, skewed prints, and printer damage. 

 After loading the trays, select the correct paper type and size on the control panel. 

 When printing, select the correct type and size in the print driver. 

 Store paper in a dry location. 

 Use only Xerox® paper and transparencies designed for the printer. 
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Avoid the following: 

 Polyester coated paper that is specially designed for inkjet printers. 

 Paper that is folded, wrinkled, or excessively curled. 

 Loading more than one type, size, or weight of paper in a tray at the same time. 

 Overfilling the trays. 

 Allowing the output tray to overfill. 

For a detailed list of supported paper, go to www.xerox.com/paper. 
 

Locating Paper Jams 
 

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a 
sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the 
printer immediately and wait 20 minutes for the fuser to cool. Try to remove the jam after the printer 
has cooled. If the error persists, contact your Xerox representative. 

 

 CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently 
damage the printer. 

The following illustration shows where paper jams can occur along the paper path: 

 
1. Output Tray 

2. Release Levers 

3. Transfer Belt 

4. Rear Cover 

5. Front Cover 

6. Bypass Tray 

7. Main Tray 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=rmlna&Language=English
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Clearing Paper Jams 

This section includes: 

 Clearing Paper Jams From the Front of the Printer .......................................................................................... 173 

 Clearing Paper Jams From the Back of the Printer ............................................................................................ 174 

 Clearing Paper Jams From the Output Tray ........................................................................................................ 176 
 

 

Clearing Paper Jams From the Front of the Printer 
 

Note: To resolve the error displayed on the control panel you must clear all paper from the paper 
path. 

 

1. Remove any paper from the bypass tray. 

2. Remove the bypass tray. 

 
3. Remove any paper jammed at the front of the printer. 
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4. Place the bypass tray on the main tray, then align the tabs with the marks. 

 
5. Follow the instructions on the control panel display and in the Printer Status window of 

PrintingScout. Press OK. 
 

Clearing Paper Jams From the Back of the Printer 
 

Note: To resolve the error displayed on the control panel you must clear all paper from the paper 
path. 

 

1. Push down on the rear cover release and pull the cover open. 

 
2. Lift the levers as shown. 
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3. Remove any jammed paper from the back of the printer. 

 
4. Lower the levers to their original position. 

 
5. Close the rear cover. 

 
6. Follow the instructions on the control panel display and in the Printer Status window of 

PrintingScout. Press OK. 
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Clearing Paper Jams From the Output Tray 
 

Note: To resolve the error displayed on the control panel you must clear all paper from the paper 
path. 

 

1. Push down on the rear cover release and pull the cover open. 

 
2. Lift the levers as shown. 

 
3. Remove any jammed paper from the back of the printer. 
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4. Lift and open the scanner. 

 
5. Remove any paper or other media from the output tray. 

 
6. Lower the scanner and close it. 

 
7. Lower the levers to their original position. 
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8. Close the rear cover. 

 
9. Follow the instructions on the control panel display and in the Printer Status window of 

PrintingScout. Press OK. 
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Troubleshooting Paper Jams 

This section includes: 

 Multiple Sheets Pulled Together .............................................................................................................................. 179 

 Paper Misfeeds ................................................................................................................................................................ 179 

 Label and Envelope Misfeeds .................................................................................................................................... 180 

 Paper Jam Message Stays On ................................................................................................................................... 180 
 

 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present.  Try a new ream of paper. 

 Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox
®

-approved paper. For details, see Supported Paper 
on page 72. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

 Remove the misfed paper and reposition it properly in the tray. 

 Adjust the paper guides in the tray to match the size of the 
paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted to 
the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, do 
not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox
®

 approved paper. For details, see Supported Paper on 
page 72. 
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Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

 Load label sheets according to the instructions from the 
manufacturer. Load labels face up in either tray. 

Envelopes are loaded incorrectly.  Load No. 10, DL, and Monarch envelopes in the trays with the 
print side up, flaps closed, flap-side down, and the short edge 
leading into the printer. 

 Load C5 envelopes with the print side up, flaps open and facing 
away from the printer. 

No. 10, DL, and Monarch envelopes are 
wrinkling. 

To prevent wrinkling on No. 10, DL, or Monarch envelopes, load them 
with the print side up, flaps open and facing away from the printer. 
 

Note: When you load envelopes long-edge feed, ensure that you 
specify landscape orientation in the print driver. 

 

 
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed all of 
the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
 
 

Note: Check for, and remove, torn pieces of paper in the paper path. 
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Print-Quality Problems 

This section includes: 

 Controlling Print Quality .............................................................................................................................................. 181 

 Solving Print-Quality Problems .................................................................................................................................. 182 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC6015support. 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 

Notes: 

 To ensure consistent print quality, the toner cartridges and imaging units for many models of 
equipment are designed to cease functioning at a predetermined point. 

 Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

 

 

 

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color 
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal 
print quality is: 15–28ºC (59–82ºF) and 20–70% relative humidity. 
 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 

 Use only Xerox® approved paper. For details, see Supported Paper on page 72. 

 Use only dry, undamaged paper. 
 

 CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, 
or damage your printer. Do not use the following: 

 Rough or porous paper 

 Inkjet paper 

 Non-laser glossy or coated paper 

 Paper that has been photocopied 

 Paper that has been folded or wrinkled 

 Paper with cutouts or perforations 

 Stapled paper 

 Envelopes with windows, metal clasps, side seams, or adhesives with release strips 

 Padded envelopes 

 Plastic media 
  

 Ensure the paper type selected in your print driver matches the paper type on which you are printing. 

 If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected 
in the print driver. 

 Store your paper and other media properly for optimum print quality. For details, see Paper Storage 
Guidelines on page 73. 
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Solving Print-Quality Problems 

When the print quality is poor, select the closest symptom from the following table and see the 
corresponding solution to correct the problem. You can also print a Demo Page to more precisely 
determine the print-quality problem. For details, see Information Pages on page 26. 

If the print quality does not improve after carrying out the appropriate action, contact your Xerox 
representative. 
 

Notes: 

 To enhance print quality, toner cartridges for many models of equipment have been designed 
to cease functioning at a predetermined point. 

 Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

 
 

Symptom Cause Solution 

Faded printouts with multiple 
colors faded. 

 

The toner cartridges are not Xerox
®

 
toner cartridges. 

Verify that the toner cartridges meet 
specifications, and replace them if 
necessary. 

The paper being used is outside the 
recommended specification range. 

Replace the paper with a recommended 
size and type, and confirm that your 
control panel and print driver settings are 
correct. For details, see Supported Paper 
on page 72. 

The paper type is heavier or thicker 
than the paper type selection. 

Adjust the paper type settings. For 
details, see Adjusting Paper Type on page 
158. 

The bias transfer voltage needs to 
be adjusted for the paper type. 

Adjust the bias transfer roller. For details, 
see Adjusting the Bias Transfer Roller on 
page 158. 

The fuser needs to be adjusted for 
the paper type. 

Adjust the fuser. For details, see Adjusting 
the Fuser on page 158. 

The paper is damp. Replace the paper. 

 

The high-voltage supply is 
defective. 

For assistance, go to the Xerox
®

 Support 
website at 
www.xerox.com/office/WC6015support. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Symptom Cause Solution 

Only one color is faded. 

 

Toner cartridge is empty or 
damaged. 

Check the condition of the toner cartridge 
and replace it if necessary. 

Stray black dots or white areas 
(dropouts). 

 

The paper is outside the 
recommended specification range. 

Replace the paper with a recommended 
size and type, and confirm that your 
control panel and print driver settings are 
correct. For details, see Supported Paper 
on page 72. 

 

The toner cartridges are not Xerox
®

 
toner cartridges. 

Verify that the toner cartridges meet 
specifications and replace them if 
necessary. For details, see Consumables 
on page 160. 

 Vertical black or color 
streaks or multiple colored 
streaks or lines. 

 Streaks in only one color. 

 

The toner cartridges are not Xerox
®

 
toner cartridges. 

Verify that the toner cartridges meet 
specifications and replace them if 
necessary. For details, see Consumables 
on page 160.  

There is a problem with the toner 
cartridge for that color. 

Check the toner cartridge for damage 
and replace if necessary. For assistance, 
go to the Xerox

®
 Support website at 

www.xerox.com/office/WC6015support. 

Color around the edge of 
printing is incorrect. 

The color registration is incorrect. Adjust the color registration. For details, 
see Color Registration on page 157. 

Partial blanks, creased paper, 
or blotted printing. 

The paper is damp. Replace the paper. 

The paper is outside the 
recommended specification range. 

Replace the paper with a recommended 
size and type. For details, see Supported 
Paper on page 72. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Symptom Cause Solution 

 

The printer is worn or damaged. For assistance, go to the Xerox
®

 Support 
website at 
www.xerox.com/office/WC6015support. 

The toner cartridges are not Xerox
®

 
toner cartridges. 

Verify that the toner cartridges meet 
specifications and replace if necessary. 
For details, see Consumables on page 
160. 

The altitude setting is incorrect. Adjust the altitude setting of the printer. 
For details, see Adjusting the Altitude on 
page 159. 

Condensation inside the printer 
causes partial blanks or creased 
paper. 

Turn on the printer and leave it on for at 
least one hour to get rid of the 
condensation. For assistance, go to the 
Xerox

®
 Support website at 

www.xerox.com/office/WC6015support. 

Vertical blanks. 

 

The lenses are being blocked. Clean the lenses in the inside of the 
printer. For details, see Cleaning the LED 
Lenses on page 152. 

The printer is worn or damaged. For assistance, go to the Xerox
®

 Support 
website at 
www.xerox.com/office/WC6015support. 

The toner cartridges are not Xerox
®

 
toner cartridges. 

Verify that the toner cartridges meet 
specifications and replace if necessary. 

Slanted printing. 

 

The paper guides in the trays are 
not set correctly. 

Reset the paper tray guides. For details, 
see Loading Paper on page 75. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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Symptom Cause Solution 

Colors are blurry or there is 
white area around objects. 

Color-to-color alignment is not 
correct. 

Perform an automatic color registration 
adjustment. For details, see Color 
Registration on page 157. 

Blotchy or mottled images. 

 

The paper is too light or too thin. Compensate for the paper thickness. For 
details, see Adjusting Paper Type on page 
158. 

The bias transfer voltage needs to 
be adjusted for the paper type. 

Adjust the bias transfer roller. For details, 
see Adjusting the Bias Transfer Roller on 
page 158. 

The fuser needs to be adjusted for 
the paper type. 

Adjust the fuser. For details, see Adjusting 
the Fuser on page 158. 

Paper curls or frequent jams in 
the rear cover. 

Bias transfer roller needs to be 
refreshed. 

Refresh the bias transfer roller. For 
details, see Refreshing the Bias Transfer 
Roller on page 159. 
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Getting Help 

This section includes: 

 Error and Status Messages ......................................................................................................................................... 187 

 PrintingScout Alerts ....................................................................................................................................................... 187 

 Online Support Assistant ............................................................................................................................................. 187 

 Information Pages ......................................................................................................................................................... 187 

 More Information .......................................................................................................................................................... 188 

Your printer comes with utilities and resources to help you troubleshoot printing problems. 

 

 

Error and Status Messages 

The printer control panel provides information and troubleshooting help. When an error or warning 
condition occurs, the control panel informs you of the problem. Error messages warn you about printer 
conditions, such as low supplies or doors open, that require your attention. 
 

PrintingScout Alerts 

PrintingScout is a utility installed with your Xerox® print driver. It automatically checks the printer status 
when you send a print job. If the printer is unable to print, a PrintingScout alert appears on your computer 
screen to let you know that the printer needs attention. In the PrintingScout dialog box, click the alert to 
view instructions explaining how to fix the problem. 
 

Note: PrintingScout is a Windows-only application. 
 
 

Online Support Assistant 

Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve 
your printer problems. You can find solutions for print-quality problems, paper jams, software installation 
issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/WC6015support. 
 

Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Quick Use Guide Packaged with the printer. 

Video Tutorials www.xerox.com/office/WC6015docs  

Recommended Media List United States: www.xerox.com/paper  

Europe: www.xerox.com/europaper  

Technical support information for your printer; includes 
online Technical Support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/WC6015support  

Information Pages Print from the control panel menu. 

Order supplies for your printer www.xerox.com/office/WC6015supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, and 
customized features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer Registration www.xerox.com/office/register  

Xerox
®

 Direct online store www.direct.xerox.com/  
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=rmlna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=rmleu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6015&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=reg&Language=English
http://www.direct.xerox.com/
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Printer Configurations and Options 

Available Configurations 

The WorkCentre 6015 Color Multifunction Printer is available in three configurations: 

 WorkCentre 6015B Color Multifunction Printer: Printer with copy, print, and scan functions, and USB 
connectivity. 

 WorkCentre 6015N Color Multifunction Printer: Network printer with copy, print, scan, and fax 
functions and USB or network connectivity. 

 WorkCentre 6015NI Color Multifunction Printer: Wireless network printer with copy, print, scan, and 
fax functions and USB, Ethernet, or wireless network connectivity. 

 

Standard Features 

The WorkCentre 6015 Color Multifunction Printer provides the following features: 
 

Feature WorkCentre 6015B 
Color Multifunction Printer 

WorkCentre 6015N/NI 
Color Multifunction Printer 

Print and Copy speed  Up to 12 ppm color 

 Up to 15 ppm black and white 

 Up to 12 ppm color 

 Up to 15 ppm black and white 

Functions Copy, scan, and print Copy, scan, print, and fax 

Print resolution 1200 x 2400 dpi 1200 x 2400 dpi 

Paper capacity  150-sheet main tray 

 10-sheet bypass tray 

 100-sheet output tray 

 150-sheet main tray 

 10-sheet bypass tray 

 100-sheet output tray 

2-Sided Printing Manual only Manual only 

Maximum copy size 216 x 297 mm (8.5 x 11.6 in.) 216 x 297 mm (8.5 x 11.6 in.) 

Maximum print size Legal (216 x 356 mm, 8.5 x 14 in.) Legal (216 x 356 mm, 8.5 x 14 in.) 

Document feeder None Automatic Document Feeder 

Control panel Button-navigated menu with four-line display Button-navigated menu with a four-line 
display and eight short address book keys 

Connectivity Universal Serial Bus (USB 2.0)  Universal Serial Bus (USB 2.0) 

 Ethernet 10/100 Base-T 

 Wireless network connectivity: Available on 
WorkCentre 6015NI Color Multifunction 
Printer only. 

Scan functions  Scan to USB Memory 

 Scan to Computer 

 Scan to USB Memory 

 Scan to Email 

 Scan to Network 

 Scan to Computer (USB) 

Scan resolution 600 x 600 dpi  600 x 600 dpi 

Remote access None CentreWare Internet Services 



Specifications 

 

 WorkCentre 6015 Color Multifunction Printer 191 
 User Guide 
 

Physical Specifications 

Weights and Dimensions 
 

 WorkCentre 6015B Color 
Multifunction Printer 

WorkCentre 6015N/NI Color 
Multifunction Printer 

Width 410 mm (16.1 in.) 410 mm (16.1 in.) 

Depth 389 mm (15.3 in.) 389 mm (15.3 in.) 

Height 318 mm (12.5 in.) 337.5 mm (13.3 in.) 

Weight 14.3 kg (31.5 lb.) 15.2 kg (33.4 lb.) 
 
 

Total Space Requirements 
 

 WorkCentre 6015B Color 
Multifunction Printer 

WorkCentre 6015N/NI Color 
Multifunction Printer 

Width 848 mm (33.4 in.) 879 mm (34.6 in.) 

Depth 936.5 mm (36.9 in.) 936.5 mm (36.9 in.) 

Height 690.5 mm (27.2 in.) 701.5 mm (27.6 in.) 
 
 

Clearance Requirements 

WorkCentre 6015B Color Multifunction Printer 
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WorkCentre 6015N/NI Color Multifunction Printer 
 

 WARNING: The WorkCentre 6015NI Color Multifunction Printer requires 20 cm (7.9 in.) separation 
from the left side of the printer to any people. 
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Environmental Specifications 

Temperature 

 Operating temperature: 10–32°C (50–90°F) 

 Optimum temperature: 15–28°C (59–82°F) 
 

Relative Humidity 

 Minimum–Maximum Humidity Range: 15–85% relative humidity at 28°C (82°F) 

 Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F) 
 

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, defects can 
occur due to condensation. 

 
 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 
 

Power Supply Voltage Power Supply Frequency 

110–127 VAC +/-10%, (99–140 VAC) 50 Hz +/- 3 Hz 

60 Hz +/- 3 Hz 

220–240 VAC +/-10%, (198–264 VAC) 50 Hz +/- 3 Hz 

60 Hz +/- 3 Hz 
 
 

Power Consumption 

 Energy Saver Mode 2 (Sleep): 8 W or less 

 Energy Saver Mode 1 (Low Power): 15 W or less 

 Ready: 37 W or less with fuser on 

 Continuous printing: 310 W or less 

This printer does not consume electric power when the power switch is turned off even if the printer is 
connected to an AC outlet. 
 

ENERGY STAR Qualified Product 

 

 

 

 

 

The WorkCentre 6015 Color Multifunction Printer is ENERGY STAR® qualified under the 
ENERGY STAR Program Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United States, 
European Union, and Japanese governments and the office equipment industry to 
promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Modes after 60 
minutes and 1 minute from the last copy or print. 
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Performance Specifications 

 

Item Specifications 

Printer warm up time Power on: 25 seconds or less. 

Recovery from sleep mode: 25 seconds or less. 
 

Note: Warm up time assumes an ambient temperature of 22ºC 
(71.6°F). 
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Controller Specifications 

Processor 

295 MHz ARM9 processor 
 

Memory 
 

Memory WorkCentre 6015B Color Multifunction 
Printer 

WorkCentre 6015N/NI Color 
Multifunction Printer 

Standard memory 128 MB RAM 128 MB RAM 

Flash memory 16 MB NVRAM 16 MB NVRAM 

Fax memory None 2 MB RAM 
 
 

Interfaces 
 

WorkCentre 6015B Color Multifunction Printer WorkCentre 6015N/NI Color Multifunction 
Printer 

Universal Serial Bus (USB 2.0) Universal Serial Bus (USB 2.0) 

Ethernet 10/100/1000Base-TX 

Wireless network connectivity: Available on WorkCentre 
6015NI Color Multifunction Printer only. 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a residential environment. This equipment generates, 
uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these 
instructions, it may cause harmful interference to radio communications. However, there is no guarantee 
that interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver. 

 Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 

 Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class B digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada. 
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European Union 
 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 

 December 12, 2006: Low Voltage Directive 2006/95/EC 

 December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 

 March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 

1. Obligations or Securities of the United States Government, such as: 

 Certificates of Indebtedness. 

 National Bank Currency. 

 Coupons from Bonds. 

 Federal Reserve Bank Notes. 

 Silver Certificates. 

 Gold Certificates. 

 United States Bonds. 

 Treasury Notes. 

 Federal Reserve Notes. 

 Fractional Notes. 

 Certificates of Deposit. 

 Paper Money. 

 Bonds and Obligations of certain agencies of the government, such as FHA and so on. 

 Bonds. United States Savings Bonds may be photographed only for publicity purposes in 
connection with the campaign for the sale of such bonds. 

 Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 
canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

 Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

 Postal Money Orders. 

 Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 

 Stamps and other representatives of value, of whatever denomination, which have been or may 
be issued under any Act of Congress. 

 Adjusted Compensation Certificates for Veterans of the World Wars. 

2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 
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3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 

6. Immigration papers. 

7. Draft Registration Cards. 

8. Selective Service Induction papers that bear any of the following Registrant’s information: 

 Earnings or Income. 

 Court Record. 

 Physical or mental condition. 

 Dependency Status. 

 Previous military service. 

 Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 

 Automobile Licenses. 

 Drivers’ Licenses. 

 Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
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Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 

 Current bank notes or current paper money 

 Obligations or securities of a government or bank 

 Exchequer bill paper or revenue paper 

 The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a 
court of law 

 Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for 
a province) 

 Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 

 Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a 
province or by the government of a state other than Canada 

 Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

 Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 

 Currency notes 

 Bank notes and checks 

 Bank and government bonds and securities 

 Passports and identification cards 

 Copyright material or trademarks without the consent of the owner 

 Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges. 
 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. See installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation 
instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected 
to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response 
to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain 
of the number of devices that can be connected to a line, as determined by the RENs, contact the local 
Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier 
that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal 
point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label. 

To order the correct service from the local Telephone Company, you could also have to quote the codes in 
the following list: 

 Facility Interface Code (FIC) = 02LS2 

 Service Order Code (SOC) = 9.0Y 
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 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line. 
Connecting this machine to an unauthorized jack can damage telephone company equipment. You, 
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this 
machine to an unauthorized jack. 

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone 
Company interrupts your service, they can advise you of your right to file a complaint with the FCC if you 
believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Machine Status menu on the 
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing 
harm to the telephone network, the Telephone Company may request you to disconnect the equipment 
until the problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized 
repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. 
Contact the state public utility commission, public service commission, or corporation commission for 
information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
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Canada 

This product meets the applicable Industry Canada technical specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 
 

 WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric 
inspection authority, or electrician, to make the ground connection. 

The REN assigned to each terminal device provides an indication of the maximum number of terminals 
allowed to be connected to a telephone interface. The termination on an interface could consist of any 
combination of devices. The only limitation to the number of devices is the requirement that the sum of 
the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the 
equipment. 
 

European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European 
single terminal connection to the public switched telephone network (PSTN). However, due to differences 
between the individual PSTNs provided in different countries, the approval does not give an 
unconditional assurance of successful operation on every PSTN network terminal point. 

In the event of a problem you should contact your authorized local dealer. 

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal 
equipment for use on analog-switched telephone networks in the European Economic Area. This product 
provides a user-adjustable setting of the country code. The country code should be set prior to connecting 
this product to the network. Refer to the customer documentation for the procedure for setting the 
country code. 
 

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we 
recommend that you set it to use DTMF signaling for more reliable and faster call setup. Modification 
of this product, connection to external control software, or connection to an external control 
apparatus not authorized by Xerox® will invalidate its certification. 

 
 

South Africa 

This modem must be used in conjunction with an approved surge protection device. 
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New Zealand 

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 
accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not 
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model. 

The equipment may not be capable of correct operation at the higher data speeds designated. 
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to 
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such 
circumstances. 

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its 
disposal or repair. 

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom 
customers. 

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is 
no guarantee that Telecom lines will always continue to support pulse dialing. 

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may 
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, 
do not contact the Telecom Faults Service. 

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is 
readily available on almost all New Zealand telephone exchanges. 

 

 WARNING: No '111' or other calls can be made from this device during a mains power failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected to 
the same line. 

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on 
the equipment (computer) associated with this device. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom Specifications: 

For repeat calls to the same number: 

 There shall be no more than 10 call attempts to the same number within any 30 minute period 
for any single manual call initiation, and 

 The equipment shall go on-hook for a period of not less than 30 seconds between the end of 
one attempt and the beginning of the next attempt. 

For automatic calls to different numbers: 

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should not 
exceed five. 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 

 North America: www.xerox.com/msds  

 European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=msdsna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=environmenteu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=customersupport&Language=English
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All Countries 

If you are managing the disposal of your Xerox® product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox® product is part of the program. For more information 
about Xerox® environmental programs, visit www.xerox.com/environment, or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6015&PgName=environmentna&Language=English
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents mean 
that used electrical and electronic products and batteries should not be 
mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 2002/96/EC 
and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a MANUFACTURER-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 

 


	Safety
	Electrical Safety
	General Guidelines
	Power Cord
	Telephone Line Cord

	Operational Safety
	Operational Guidelines
	Ozone Release
	Printer Location
	Printer Supplies

	Maintenance Safety
	Printer Symbols
	Environmental, Health, and Safety Contact Information

	Features
	Parts of the Printer
	Front View
	Rear View
	Control Panel
	Control Panel Buttons and Indicators
	Control Panel Symbols


	System Menus
	Information Pages
	Billing Meters
	Admin Menu
	Fax Book
	Network
	Wired Network Setup
	Wireless Network Setup

	Fax Settings
	System Setup
	Maintenance
	Secure Settings
	Scan to Email
	USB Setup

	Default Settings Menu
	Copy Defaults
	Scan Defaults
	Fax Defaults
	Print from USB Defaults

	Tray Settings
	Panel Language

	Energy Saver Mode
	Setting the Power Saver Timer
	Exiting Energy Saver Mode

	Administration Features
	Information Pages
	System Settings Page

	CentreWare Internet Services
	Accessing CentreWare Internet Services


	More Information
	Xerox® Welcome Center
	Locating the Serial Number



	Installation and Setup
	Installation and Setup Overview
	Selecting a Location for the Printer
	Connecting the Printer
	Selecting a Connection Method
	Connecting to a Wired Network
	Connecting to a Wireless Network
	Resetting Wireless Settings
	Connecting to a Network With a Wi-Fi Protected Setup-Compliant Router
	Connecting to a Wireless Network Manually

	Connecting to a Computer Using USB
	Connecting to a Telephone Line

	Configuring Network Settings
	About TCP/IP and IP Addresses
	Assigning the IP Address of the Printer
	Assigning the IP Address Automatically
	Assigning the IP Address Manually
	Finding the IP Address of the Printer
	Changing the IP Address Using CentreWare Internet Services

	Setting Up the Fax Header
	Adding Fax Numbers and Email Addresses to the Address Book

	Enabling the Printer for Scanning

	Setting the Date and Time
	Installing the Software
	Operating System Requirements
	Available Print Drivers
	Installing the Print Drivers for a Windows Network Printer
	Installing the Print Drivers for a Windows USB Printer
	Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later
	Installing the Print Driver
	Adding the Printer
	Utilities


	Setting Up Scanning
	Scanning Setup Overview
	Setting Up Scanning to a Shared Folder on Your Computer
	Sharing a Folder Using Windows
	Sharing the Folder Using Macintosh OS X Version 10.5 and Later
	Adding the Folder as an Address Book Entry Using the Address Book Editor
	Adding the Folder as an Address Book Entry Using CentreWare Internet Services

	Setting Up Scanning to an FTP Server
	Setting Up Scanning to an Email Address
	Setting Up Scanning With USB
	Setting Up Scanning to a Folder on Your Computer With USB



	Printing
	Supported Paper
	Recommended Media
	Ordering Paper
	General Paper Loading Guidelines
	Paper That Can Damage Your Printer
	Paper Storage Guidelines
	Supported Standard Paper Sizes
	Supported Custom Paper Sizes
	Supported Paper Types and Weights

	Loading Paper
	Loading Paper in the Main Tray
	Loading Paper in the Bypass Tray
	Setting Paper Types, Paper Sizes, and Display Screen

	Selecting Printing Options
	Selecting Printing Defaults in Windows
	Selecting Printing Defaults in Windows for a Shared Network Printer
	Selecting Printing Options for an Individual Job in Windows
	Selecting Printing Options for Macintosh

	Printing Envelopes
	Guidelines for Printing Envelopes
	Loading Envelopes in the Trays
	Specifying the Main Tray Settings for Printing Envelopes
	Printing Envelopes From an Application

	Using Custom Paper Sizes
	Defining Custom Paper Sizes
	Defining a Custom Paper Size for Windows
	Defining a Custom Paper Size for Macintosh

	Printing on Custom Paper Sizes
	Printing on Custom Paper Size Using Windows
	Printing on Custom Paper Size Using Macintosh


	Printing on Both Sides of the Paper
	Setting Up 2-Sided Printing
	Loading Paper for Manual 2-Sided Printing

	Printing From a USB Flash Drive

	Copying
	Making Copies
	Automatic Document Feeder Guidelines
	Document Glass Guidelines

	Adjusting Copying Options
	Basic Settings
	Selecting Color or Black and White Copies
	Specifying the Original Size
	Specifying the Original Document Type

	Image-Quality Settings
	Reducing or Enlarging the Image
	Making the Image Lighter or Darker
	Adjusting the Sharpness
	Setting Auto Exposure

	Image Layout Adjustments
	Printing Multiple Pages per Side
	Setting Copy Margins

	Output Adjustments
	Collating Copies


	Changing the Default Copy Settings
	Changing the Color Mode
	Changing the Auto Exposure Level
	Changing the Color Balance
	Changing the Manual Feed Slot Paper Size

	Limiting Access to Copying

	Scanning
	Loading Documents for Scanning
	Automatic Document Feeder Guidelines
	Document Glass Guidelines

	Scanning to a USB Flash Drive
	Scanning to a Folder on a USB Connected Computer
	Scanning to a Shared Folder on a Network Computer
	Sharing a Folder on a Windows Computer
	Sharing a Folder Using Macintosh OS X Version 10.5 and Later
	Adding a Folder as an Address Book Entry Using CentreWare Internet Services
	Adding a Folder as an Address Book Entry Using the Address Book Editor
	Scanning to a Folder on a Network Computer

	Scanning to an Email Address
	Scanning to an FTP Server
	Scanning Images into an Application on a USB Connected Computer
	Scanning an Image into an Application
	Scanning an Image Using Windows XP
	Scanning an Image Using Widows Vista or Windows 7

	Adjusting Scanning Settings
	Setting the File Format
	Setting the Color Mode
	Setting the Scan Resolution
	Specifying the Original Size
	Making the Image Lighter or Darker
	Adjusting the Sharpness
	Changing the Auto Exposure Level
	Setting the Margins

	Changing the Default Scan Settings
	Setting the Scan to Network Option
	Setting the File Format
	Changing the Color Mode
	Setting the Scan Resolution
	Setting the Color Button Sets
	Specifying the Original Size
	Making the Image Lighter or Darker
	Adjusting the Sharpness
	Changing the Auto Exposure Level
	Setting the Margins
	Setting the TIFF File Format
	Setting the Image Compression
	Setting the Maximum Email Size

	Limiting Access to Scanning

	Faxing
	Loading Documents for Faxing
	Basic Faxing
	Sending a Fax From the Printer
	Sending a Fax From Your Computer
	Sending a Fax Using Windows Applications
	Sending a Fax Using Macintosh Applications


	Using the Fax Book
	Faxing to an Individual
	Adding an Individual Fax Address Book Entry
	Faxing to an Individual in the Address Book

	Faxing to a Group
	Creating a Fax Group
	Editing Address Book Fax Groups
	Faxing to an Address Book Group
	Searching the Local Phone Book


	Selecting Fax Options for Single Jobs
	Setting the Fax Resolution
	Making the Image Lighter or Darker
	Turning OnHook On or Off
	Sending a Delayed Fax
	Including a Fax Cover Page
	Setting Up Polling

	Configuring the Printer for Faxing
	Changing the Default Fax Settings

	Managing Fax Functions
	Printing Monitor Reports
	Printing a Monitor Report for a Group Fax
	Turning Secure Fax Receive On or Off
	Printing Secure Faxes

	Limiting Access to Faxing
	Changing the Panel Lock Password
	Limiting Who Can Send Faxes to the Printer

	Printing Fax Reports
	Inserting Pauses in Fax Numbers


	Maintenance
	Cleaning the Printer
	General Precautions
	Cleaning the Scanner
	Cleaning the Exterior
	Cleaning the Interior
	Cleaning Inside the Printer
	Cleaning the LED Lenses
	Cleaning the Color Toner Density Sensors


	Adjustments and Maintenance Procedures
	Color Registration
	Setting Automatic Color Registration
	Performing an Automatic Color Registration Adjustment

	Adjusting Paper Type
	Adjusting the Bias Transfer Roller
	Adjusting the Fuser
	Refreshing the Bias Transfer Roller
	Adjusting the Altitude

	Ordering Supplies
	Consumables
	When to Order Supplies
	Toner Cartridges
	General Precautions
	Replacing a Toner Cartridge
	Refreshing the Toner
	Cleaning the Developer

	Recycling Supplies

	Managing the Printer
	Checking Page Counts
	Printing the System Settings Page
	Viewing the Billing Meters

	Changing the Panel Lock Password

	Moving the Printer

	Troubleshooting
	General Troubleshooting
	Printer Does Not Turn On
	Printer Resets or Turns Off Frequently
	The Printer Does Not Print
	Printer is Making Unusual Noises
	Condensation has Formed Inside the Printer

	Paper Jams
	Minimizing Paper Jams
	Locating Paper Jams
	Clearing Paper Jams
	Clearing Paper Jams From the Front of the Printer
	Clearing Paper Jams From the Back of the Printer
	Clearing Paper Jams From the Output Tray

	Troubleshooting Paper Jams
	Multiple Sheets Pulled Together
	Paper Misfeeds
	Label and Envelope Misfeeds
	Paper Jam Message Stays On

	Print-Quality Problems
	Controlling Print Quality
	Paper and Media

	Solving Print-Quality Problems


	Getting Help
	Error and Status Messages
	PrintingScout Alerts
	Online Support Assistant
	Information Pages
	More Information


	Specifications
	Printer Configurations and Options
	Available Configurations
	Standard Features

	Physical Specifications
	Weights and Dimensions
	Total Space Requirements
	Clearance Requirements

	Environmental Specifications
	Temperature
	Relative Humidity
	Elevation

	Electrical Specifications
	Power Supply Voltage and Frequency
	Power Consumption
	ENERGY STAR Qualified Product

	Performance Specifications
	Controller Specifications
	Processor
	Memory
	Interfaces


	Regulatory Information
	Basic Regulations
	United States FCC Regulations
	Canada
	European Union
	Turkey RoHS Regulation

	Copy Regulations
	United States
	Canada
	Other Countries

	Fax Regulations
	United States
	Fax Send Header Requirements
	Data Coupler Information

	Canada
	European Union
	Radio Equipment and Telecommunications Terminal Equipment Directive

	South Africa
	New Zealand

	Material Safety Data Sheets

	Recycling and Disposal
	All Countries
	North America
	European Union
	Domestic/Household Environment
	Professional/Business Environment
	Collection and Disposal of Equipment and Batteries
	Business Users in the European Union
	Disposal Outside of the European Union

	Battery Symbol Note
	Battery Removal

	Other Countries


